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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002-2006, 2009 Hewlett-Packard Development Company, L.P.

Trademark Notices

UNIX® is a registered trademark of The Open Group. 

Windows® is a US registered trademark of Microsoft Corporation.

Java™ is a US trademark of Sun Microsystems, Inc.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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1 Oracle AS SPI Concepts
The HP Operations Smart Plug-in for Oracle Application Server (Oracle AS SPI) enables you 
to manage Oracle Application Servers from an HP Operations Manager for UNIX (HPOM) 
console. Oracle AS SPI adds monitoring capabilities otherwise unavailable to HPOM. For 
more information on HPOM, see HP Operations Manager for UNIX  Concepts Guide.

Introducing the Oracle AS SPI

The Oracle AS SPI, used in conjunction with HPOM, offers centralized applications that help 
you monitor and manage systems using Oracle Application Server. From the HPOM console, 
you can monitor the availability, use, and performance of Oracle Application Servers running 
on HPOM managed nodes. You can set threshold values for Oracle AS SPI metrics. When 
these thresholds are crossed Oracle AS SPI generates an alarm and message. The metrics can 
also be consolidated into reports and graphs which help you analyze trends in server usage, 
availability, and performance. You can integrate Oracle AS SPI with HP Reporter and HP 
Performance Manager to get additional reporting and graphing flexibility and capabilities. 
For details on integrating Oracle AS SPI with other HP products, see Chapter 5, Integrating 
HPOM Reporting and Graphing Products with the Oracle AS SPI.

Smart Plug-in Data

The Oracle AS SPI has several server-related metrics that gather data about the following:

• Server availability

• Server performance

• JVM memory usage

• EJB client and method wrapper active threads, execution times, and calls processed

• Servlet execution times and threads

• JSP service time and active requests

• Java message service connections and messages

• JDBC connection status

• Web application processing and open sessions

• HTTP server active connections and processed data
13



Smart Plug-in Uses and Customizations

As a Oracle AS SPI administrator, you can choose the metrics most crucial for the operation of 
Oracle Application Server by modifying Oracle AS SPI templates. These templates contain 
settings that enable incoming data to be measured against predefined rules. These rules 
generate useful information in the form of messages. These message have color-coding to 
indicate the severity level. You can review these messages for problem analysis and 
resolution. There are several pre-defined corrective actions for specific events or threshold 
violations. These corrective actions can be automatically triggered or operator-initiated. When 
you double-click a message, corrective actions appear under the Instructions tab and 
automatically generated metric reports appear under the Annotations tab.

Functions of the Oracle AS SPI

Oracle AS SPI messaging, reporting, and action-executing capabilities are based on the 
HPOM concept of templates. For more information, see HP Operations Manager for UNIX  
Concepts Guide. The settings within these templates define various conditions that can occur 
within the Oracle Application Server and enable information to be sent back to the HPOM 
management server. This helps you to proactively address potential or existing problems and 
avoid serious disruptions to web transaction processing. Oracle AS SPI performs the following 
functions described in the following sections:

Collecting and Interpreting Server Performance and Availability Information

After you configure the Oracle AS SPI, and the templates are deployed to the managed nodes, 
the SPI starts gathering server performance and availability data. This data is compared with 
the settings within the deployed templates. The templates define conditions that can occur 
within the Oracle AS Server, such as queue throughput rates, cache use percentages, timeout 
rates, and average transaction times. The templates monitor these conditions against default 
thresholds (set within the templates) and trigger messages when a threshold has been 
exceeded.

Displaying Information

The Oracle AS SPI templates generate messages when a threshold is exceeded. These 
messages can appear as:
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Messages in the Message Browser – HP Operations agent software compares the values 
gathered for Oracle AS Server performance and availability against the monitor template 
settings related to those specific areas. The agent software then forwards appropriate 
messages to the HPOM console. These messages appear with color-coded severity levels in the 
HPOM message browser. 

Instruction Text – Messages generated by the Oracle AS SPI programs contain instruction 
text to help analyze and solve problems. You can manually perform corrective actions 
preassigned to events or they can be triggered automatically.Instruction text is usually 
present in the message details. Instruction text is also available in the HP Operations Smart 
Plug-in for Oracle Application Server Reference Guide.
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ASCII-Text Reports - In addition to the instruction text, some messages cause automatic 
action reports to be generated. These reports display conditions of a specific Oracle OC4J/
OHS server instance. If a report is available, you can find it within the Annotations area of 
the Message Details. 

Generating Reports Using HP Reporter

You can integrate the Oracle AS SPI with HP Reporter to provide you with 
management-ready, web-based reports. The Oracle AS SPI Report package includes the 
templates for generating these reports. You can install the Report package on the Reporter 
Windows system.

After you install the product and complete basic configuration, Reporter generates reports of 
summarized, consolidated data every night. With the help of these reports you can assess how 
the Oracle OC4J/OHS server is performing over a period of time.
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Graphing Data with HP Performance Manager

Metrics collected by the Oracle AS SPI can be graphed. The values can then be viewed for 
trend analysis.

You can integrate the Oracle AS SPI with HP Performance Manager to generate and view 
graphs (use the View Graphs application from the OASSPI Admin applications group to view 
graphs). These graphs display the values of the metrics collected by the Oracle AS SPI. You 
can click Perform Action to view graphed data from almost all the Oracle AS SPI alarm 
messages. Perform Action is present in the message browser and in the message details (you 
can access details by either double-clicking the message or clicking Details...in the message 
browser) in the message browser. The action launches your web browser, where you can 
choose a graph that displays values for the metric which generated the message as well as 
other related metrics

Customizing Templates and Metrics

You can use Oracle AS SPI templates without customization, or you can modify them to suit 
the needs of your environment. Some of the modifications and customizations that you can do 
are the following:

• Modify the default templates– Within a template, you can change the default settings for:

— Collection interval

— Threshold

— Message text

— Duration

— Severity level of the condition

— Actions assigned to the condition (operator-initiated or automatic)

• Create custom template groups– You can create custom template groups, using default 
templates as base. For more information, see Chapter 4, Customizing the Oracle AS SPI 
Templates.

• Create custom metrics– You can define your own metrics or User Defined Metrics (UDMs) 
to expand the monitoring capabilities of the Oracle AS SPI. For more information about 
UDMs see the HP Operations Smart Plug-in User Defined Metrics User Guide.

Components of the Oracle AS SPI

The Oracle AS SPI has two main components:

• Applications (including reports) 

• Templates 

You can use the applications and templates to configure and receive data in the form of 
messages, annotations, and metric reports. These messages (available in the message 
browser), annotations (available through message properties), and metric reports (available 
through applications or message details) provide information about the conditions present in 
the servers running on specific managed nodes. 
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The Oracle AS SPI configuration applications let you configure the management server’s 
connection to selected server instances on specific managed nodes. After you configure the 
connection, you can assign templates to the nodes. With HP Operations agent software 
running on the managed nodes, you can use the Oracle AS SPI reporting applications to 
generate metric reports. In addition, you can generate graphs which show the Oracle AS SPI 
data (available through message properties). 

 Applications

The Oracle AS SPI applications include configuration, troubleshooting, and report-generating 
utilities. 

Oracle AS SPI version 6.10 uses JMX standards to discover and monitor  Oracle Application 
Server 10gR3. The metrics, templates, and reports for Oracle AS, therefore, are now divided 
in two groups. For example, the OASSPI Reports is divided into OASSPI Reports group and 
OASSPI Reports (JMX) group. These groups are explained in detail in the following sections.

• OASSPI Admin Applications Group

• Oracle AS SPI Applications Group

• OASSPI Reports Group

• OASSPI Reports (JMX) Group

• JMX Metric Builder Applications: This application group is available only if you install 
the SPIJMB software. 
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OASSPI Admin Applications Group

OASSPI Admin applications enable you to configure, control, and troubleshoot the Oracle AS 
SPI. You require root user permission to run OASSPI Admin applications. 

The group contains the following applications:

• Configure OASSPI– Launches the configuration editor and maintains the Oracle AS 
SPI configuration.

• Discover Oracle AS– Sets basic configuration properties needed for discovery.

• Init Non-Root– Simplifies the configuration of a non-root HTTPS agent on a UNIX 
managed node (OVO 8.x only). For all the steps necessary to configure a non-root HTTPS 
agent on a UNIX managed node, see Configuring a Non-Root HTTPS Agent on a UNIX 
Managed Node (OVO 8.x Only) on page 50. 

• Self-Healing Info– Collects data to be sent to your HP Support representative.

• Start Monitoring– Starts the collection of metrics for one or more OC4J/OHS servers on 
a managed node. 

Launch the Verify application to determine if monitoring is started or stopped. By default, 
monitoring is on.

• Stop Monitoring– Stops the collection of metrics for one or more OC4J/OHS servers on a 
managed node. 

• Start Tracing– Starts the tracing of the collection of metrics into a file. Run this 
application only when instructed by your HP support representative.
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• Stop Tracing– Stops the tracing of the collection of metrics into a file. Run this 
application only when instructed by your HP support representative.

• Verify– Verifies that the Oracle AS SPI is properly installed on the server or managed 
node. 

• View Error Log– Enables you to view the contents of the Oracle AS SPI error log file. 

• View Graphs– Enables you to view Oracle AS SPI graphs, generated by HP Performance 
Manager, in a web browser. This requires additional setup. For more information, see 
Task 1: Configure the Management Server to Launch Your Web Browser on page 35.

For more information about each of the above applications, see Appendix C, Applications.

Oracle AS SPI Applications Group

You can manage the Oracle Application Server functions by using the applications in the 
Oracle AS SPI applications group. 

To access the applications in the Oracle AS SPI group double-click OASSPI  Oracle AS in the 
Application Bank window.

 

The Oracle AS SPI applications group contains the following applications:

• Launch Oracle AS Console– Launches the Oracle Application Server Control Console, 
launch the AggreSPY servlet, or the Oracle Enterprise Manager Database Control 
(requires setup).

• Start Oracle AS– Enables you to start the Oracle Application Server (requires setup).

• Stop Oracle AS– Enables you to stop the Oracle Application Server (requires setup).
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• View OAS Logs– Enables you to view the Oracle Application Server log files.

• View Status– Does an interactive status check of the Oracle Application Server.

OASSPI Reports Group

OASSPI Reports group contains reports that show information about the condition of the 
Oracle Application Server. 

You can generate these reports manually by dragging a managed node to a report in the 
Application Bank window. Each report reflects shows the condition of all configured server 
instances on the managed node in relation to the metric for which the report is generated. The 
following is a sample Oracle AS SPI Application Bank Report.

Application Bank Reports Generated from Alarms

An alarm condition can generate a report. These reports are generated automatically and are 
context sensitive, relating only to a single server on the managed node. These reports appear 
within the Annotations section of a message. 

If you configure the message browser to display the SUIAONE columns, a flag appears under 
the S column (adjacent to the message) when a report is generated.

OASSPI Reports (JMX) Group

Oracle AS SPI Reports (JMX) group contains ASCII metric reports that display information 
about the condition of the Oracle Application Server 10gR3 using JMX standards. 

JMX Metric Builder Applications

The JMX Metric Builder Applications group contains the following applications:

• Deploy UDM– Deploys the UDM file.
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• Gather MBean Data–Collects MBean information that is used with the JMX Metric 
Builder.

• JMX Metric Builder– Launches the JMX Metric Builder application that is used to 
create UDMs and browse MBeans.

• UDM Graph Enable/Disable– Starts/stops data collection for UDM graphs. Also starts/
stops the HP Operations subagent.

For more information about the JMX Metric Builder Applications group and steps to install 
the SPIJMB software, see the HP Operations Smart Plug-in for User Defined Metrics User 
Guide.

Oracle AS SPI Template Groups and Templates

Oracle AS SPI templates are organized in groups and sub-groups. 

The SPI for Oracle AS template group contains:

• OASSPI: This group contains the following sub-groups:

— OASSPI-Logfiles – Contains templates that generate messages based on log file and 
error text detected in both the Oracle Application Server log files and the Oracle AS 
SPI log files. The information captured from these log files includes errors that occur 
in the operation of the Oracle Application Server or the Oracle AS SPI and changes 
made to Oracle Application Server configuration.
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— OASSPI-Metrics – Contains metric templates that monitor the performance levels 
and availability of Oracle OC4J/OHS servers.

Each metric template determines the threshold conditions for the monitored metric, 
the message text that is sent to the HPOM message browser when the threshold is 
exceeded, the actions to start, and instructions that appear.

— OASSPI-Metrics [JMX] –  Contains metric templates that monitor the performance 
levels and availability of Oracle OC4J/OHS servers. These metric templates are 
available only for Oracle Application Server version 10gR3.

— OASSPI-Monitors – Contains collector templates that specify the collection interval 
of the metric templates. Within the name of each collector template is its collection 
interval. For example, the collection interval of the template OASSPI-10-OHS-15min 
is 15 minutes (where 15min represents 15 minutes). Each collector template is 
assigned a collection interval of 5 minutes, 15 minutes, or one hour.

When you open a collector template, you can see the metrics collected within the 
interval (listed by number, following the -m option of the collector/analyzer command 
wasspi_oas_ca).

Each collector template controls which metrics are collected when. Specifically, the 
collector template does the following: 

– Runs the collector/analyzer at each collection interval

– Specifies which metrics are collected

— OASSPI-Monitors [JMX] – Contains JMX collector templates that specify the 
collection interval of the JMX metric templates. These templates are only for Oracle 
AS version 10gR3.

— OASSPI-Messages – This is a single template. It intercepts Oracle AS SPI messages 
for the HPOM message browser.

• OASSPI Discovery:

— OASSPI-Messages – This is a single template. It intercepts Oracle AS SPI messages 
for the HPOM message browser.

—  OASSPI Service Discovery: This is a single template. It updates the configuration 
on the HPOM management server and managed nodes.

In the message browser shown above, all the messages are generated by Oracle AS SPI 
templates that belong to the Oracle AS and OASSPI Message Groups (see the column titled 
MsgGroup), indicating their origins. The Oracle AS messages indicate conditions occurring in 
Oracle OC4J/OHS servers while the OASSPI message indicates a condition occurring in the 
Oracle AS SPI.
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For Oracle AS SPI version 6.10, you will also see another policy group called Generic JMX.  
This group can be expanded into the following sub groups : 

— JMX-Metrics

— JMX-Monitors
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2 Installing, Upgrading, and Removing the 
Oracle AS SPI
Installing the Oracle AS SPI

For a complete list of software requirements, see the HP Operations Smart Plug-in for Oracle 
Application Server Release Notes.

The instructions that follow show the command line usage of swinstall. For HP-UX systems, 
you can also use the graphical user interface (GUI), but the GUI method is not covered.

For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.depot OASSPI 

On a Solaris management server the packages are supported in both depot and solaris native 
format.

For a Solaris management server in depot format, type:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot OASSPI

For a Solaris management server in native format,  perform the folowing steps:

1 Before installing the SPI software on the Solaris management server, set 
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the 
installation. Type:

PKG_NONABI_SYMLINKS=TRUE

export PKG_NONABI_SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two 
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and 
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the 
HPOMSpiDVD-8.1.sparc package. 

3 To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc

4 Select the following SPIs for installation:

• HPOvSpiOas

• HPOvSpiJmx

• HPOvSpiShs

It is not necessary to stop HPOM sessions before beginning the Oracle AS SPI installation.
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Upgrading the Oracle AS SPI

When you upgrade from a previous installation, all your configuration entries are preserved.

To upgrade Oracle AS SPI, complete these tasks:

• Task 1: Remove Oracle AS SPI Software from the Management Server

• Task 2: Delete Oracle AS SPI Templates

• Task 3: Delete Oracle AS SPI Applications

• Task 4: Upgrade the Management Server

• Task 5: Assign Operator Responsibilities for opc_adm

• Task 6: Assign Templates to the Management Server

• Task 7: Distribute Templates to the Management Server

• Task 8: Customize Templates

• Task 9: Move Nodes to New Node Group (Verify)

• Task 10: Delete Oracle Application Server Node Group

• Task 11: Distribute Actions, Monitors, Commands, and Templates

• Task 12: Launch the Discover Oracle AS Application

• Task 13: Install the New Report Package (Optional)

• Task 14: Install the New Graph Package (Optional)

Task 1: Remove Oracle AS SPI Software from the Management Server

1 Open a terminal window and log on as root.

2 In the terminal window:

• For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

/usr/sbin/swremove OASSPI
/usr/sbin/swremove SPIOracleASAll
/usr/sbin/swremove OASSPI-GRAPHS

• For a Solaris management server, type:

/usr/sbin/pkgrm HPOvSpiOas
/usr/sbin/swremove DSI2DDF/
/usr/sbin/swremove SPI-SVCDISC-OVO

3 Run the following command to delete all the SPI files in the /opt/OV/wasspi/oas/bin/ 
directory

cd /opt/OV/wasspi/oas/bin
find . -name “wasspi_oas*” -exec rm {} \;

This deletes all files that begin with wasspi_oas.
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Task 2: Delete Oracle AS SPI Templates

Delete all Oracle AS SPI templates and template groups that appear under the
SPI for Oracle AS template group and then delete the SPI for Oracle AS template group. If 
you customize any of the default templates, note these changes (the customizations are not 
saved). Follow these steps:

1 From the windows menu select Message Source Templates and select the SPI for Oracle AS 
template group.

2 Double-click SPI for Oracle AS. All the template groups and individual templates in the 
group appear. 

3 Click OASSPI- Logfiles to open the individual templates in that group. Press Ctrl and click 
to select all the templates.

4 Click Delete From All.... The following message appears:

Do you really want to delete the template(s)?

5 Click Yes.

6 Go up a level and open the next group. Repeat steps 2 through 5 until you delete all Oracle 
AS SPI individual and group templates in the Message Source Template window. 

Task 3: Delete Oracle AS SPI Applications

1 Open the Application Bank.

2 Right-click the OASSPI application group and click Delete. The following message 
appears:

Do you really want to delete the application group?

3 Click Yes.

Task 4: Upgrade the Management Server

The Oracle AS SPI software is available on the HP Operations Smart Plug-ins DVD. 

For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.depot OASSPI

On a Solaris management server the packages are supported in both depot and solaris native 
format.

For a Solaris management server in depot format, type:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot OASSPI

For a Solaris management server in native format,  perform the folowing steps:

1 Before upgrading the SPI software on the Solaris management server, set 
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the 
installation. Type:

PKG_NONABI_SYMLINKS=TRUE

The instructions that follow show the command line usage of swinstall. For HP-UX systems, 
you can also use the graphical user interface (GUI).
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export PKG_NONABI_SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two 
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and 
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the 
HPOMSpiDVD-8.1.sparc package. 

3 To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc

4 Select the following SPIs for upgrading:

• HPOvSpiOas

• HPOvSpiJmx

• HPOvSpiShs

Task 5: Assign Operator Responsibilities for opc_adm

1 Log on to HPOM as administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and click Modify.

3 In the Modify User:opc_adm user window, click Responsibilities. 

4 For OASSPI and Oracle AS Message Groups, ensure that all check boxes are selected.

5 Assign the OASSPI Node or Message Groups to some other appropriate operators.

6 Click Close.

Task 6: Assign Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Assign Templates. The Define Configuration 
window opens.

3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 In the Template Groups pane, select the SPI for Oracle Server template group.

6 From the Message Source Templates window, in the right pane, select the 
OASSPI-Discovery template and OASSPI-Messages template.

7 From the Add Configuration window, click Get Template Selections. The OASSPI-Messages 
and OASSPI-Discovery templates appear in the right pane.

8 From the Add Configuration window, click OK.

Task 7: Distribute Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Install/Update SW & Config. 

3 In the Target Nodes section, select Nodes in List Requiring Update.

4  In the Install/Update Software and Configuration window select the Templates check box.
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5 Select Force Update.

6 Click OK.

The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates

Task 8: Customize Templates

1 Copy the default templates.

2 Apply the customizations made to the previous version of templates to the copy of the 
current version.

Task 9: Move Nodes to New Node Group (Verify)

Move all managed nodes (running supported versions of the Oracle Application Server) in the 
Oracle AS node group to the new Oracle AS node group. Follow these steps:

1 Open the Node Bank and double-click Oracle AS node group.

2 Note the managed nodes in it. 

3 Go back to the top level of the node bank (where the Oracle AS node group is displayed)

4 Drag and drop, or copy and paste, the nodes (noted in step 2) from the IP submap to the 
Oracle AS node group.

Task 10: Delete Oracle Application Server Node Group

1 Open the Node Bank and select Oracle AS node group.

2 From the Edit menu, click Delete. The following message appears:

Do you really want to delete the node group?

3 Click Yes.

Task 11: Distribute Actions, Monitors, Commands, and Templates

1 From the Node Bank window, select the nodes or node groups on which you want to install 
the Oracle AS SPI. 

2 From the Actions menu select Agents  Install/Update SW & Config. 

3 In the Install/Update HPOM Software and Configuration window, select the following 
component check boxes:

• Templates

• Actions

• Monitors

• Commands

Using this dialog, deploy updated components on the managed nodes.
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4 Select the Force Update check box.

5 Select the Nodes in list option button. Upon completion, the following message appears in 
the message browser for each managed node:

The following configuration information was successfully distributed: 
Actions Commands Monitors Templates.

Task 12: Launch the Discover Oracle AS Application

You must launch the Discover Oracle AS application. You are not required to re-enter any of 
the Oracle AS SPI configuration data because all configuration data is saved. To re-deploy the 
file, you can drag and drop multiple nodes, node groups, or single nodes. When you re-deploy 
the file, relevant information is updated, transmitted, and stored on the node. Follow these 
steps:

1 From the HPOM console, select the node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window, select OASSPI  OASSPI Admin  Discover Oracle AS. (If 
the above does not appear as described, select Map  Reload). The Introduction window 
opens. 

4 Click Next. A second Introduction window opens. Information about the properties 
required for the discovery process to work are given in this window

5 Read this information and click Next. The configuration editor opens.

6 Make the necessary changes using the configuration editor.

7 Click Next to save any changes and exit the editor. The Confirm Operation window opens.

8  Click OK.

If you click Cancel, all the changes made to the configuration will remain in the 
configuration on the management server. To make the changes to the selected managed 
nodes’ configuration, you must select those nodes in the Node Bank window, launch the 
Discovery application, click Next in the configuration editor, and then click OK in the 
Confirm Operation window.

You might see some Oracle AS SPI errors in the message browser. These errors are the result 
of the transition to the updated programs and you can ignore them. Oracle AS SPI templates 
and programs are updated on the Management Server and selected managed nodes. These 
errors are resolved when the upgrade is complete.

When setting the configuration using configuration editor, note the following:
• GRAPH_SERVER property is no longer supported in the Oracle AS SPI. 

Instead, set the GRAPH_URL property.
• After you consolidate the UDMs on the management server, delete the old 

UDM files from the managed nodes and distribute the new UDM file to the 
managed nodes using the Deploy UDM application.

Do not close the Discover application window until the discovery process is complete. The 
discovery process might take several minutes to complete.
30 Chapter 2



Task 13: Install the New Report Package (Optional)

Remove older versions of the Oracle AS SPI report package from your Windows system 
running HP Reporter and install the new Oracle AS SPI report package. To install the new 
report package, follow these steps:

1 On the Windows system running HP Reporter, go to Settings  Control Panel Add/Remove 
Programs.

2 Select the Oracle AS SPI report package and click Remove.

3 To install the Oracle AS SPI report package, follow the steps in Integrating with HP 
Reporter on page 70.

Task 14: Install the New Graph Package (Optional)

• If HP Performance Manager is running on a Windows system, remove older versions of 
Oracle AS SPI graph package and install the new Oracle AS SPI graph package. To install 
the new graph package, follow these steps:

a Go to Settings  Control Panel  Add/Remove Programs.

b Select the Oracle AS SPI graph package (HP Operations Manager SPI for Oracle AS - 
Graphing Component Integration) and click Remove.

c To install the Oracle AS SPI graph package, follow the steps in Integrating with HP 
Performance Manager on page 72.

• If HP Performance Manager is running on a HP-UX system (not the HPOM management 
server), follow these steps: 

a Run swlist | grep OASSPI-GRAPHS to verify that the graph package is installed. 

b Run swremove OASSPI-GRAPHS if the graph package is installed.

c To install the Oracle AS SPI graph package, follow the steps in Integrating with HP 
Performance Manager on page 72.

• If HP Performance Manager is running on a Solaris system (not the HPOM management 
server), follow these steps: 

a Run /usr/bin/pkginfo HPOvSpiOasGc to verify that the graph package is 
installed.

b Run /usr/sbin/pkgrm HPOvSpiOasGc if the graph package is installed.

To install the Oracle AS SPI graph package, follow the steps in Integrating with HP 
Performance Manager on page 72.

If HP Performance Manager is installed on the HPOM management server, the 
files are automatically updated when you install the SPI software.

If HP Performance Manager is installed on the HPOM management server, the 
files are automatically updated when you install the SPI software.
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Removing the Oracle AS SPI

The complete removal of the Oracle AS SPI installation deletes all Oracle AS SPI components. 

Complete the following tasks: 

• Task 1: Remove Oracle AS SPI Software from the Management Server

• Task 2: Remove Oracle AS SPI Software from the Node Group and Managed Nodes

• Task 3: Delete Oracle AS SPI Templates and Template Groups

• Task 4: Delete Oracle AS SPI Applications

• Task 5: Delete the Oracle AS SPI Message and Node groups

• Task 6: Remove the Report Package (Optional)

• Task 7: Remove the Graph Package (Optional)

Task 1: Remove Oracle AS SPI Software from the Management Server

1 Open a terminal window and log on as root.

2 In the terminal window:

• For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

/usr/sbin/swremove OASSPI
/usr/sbin/swremove OASSPI-GRAPHS

• For a Solaris management server in depot format, type:

/usr/sbin/swremove OASSPI/
/usr/sbin/swremove OASSPI-GRAPHS

• For a Solaris management server in native format, type:

/usr/sbin/pkgrm HPOvSpiOas

The swremove and pkgrm command removes the files from the file system only. The Oracle AS 
SPI templates are still in the HPOM data repository and must be deleted manually. Before 
the templates can be deleted, they (and the Oracle AS SPI software) must be de-assigned from 
the managed nodes.

Task 2: Remove Oracle AS SPI Software from the Node Group and Managed 
Nodes

1 Open the Node Bank and, from the Actions menu, select Agents  Assign Templates.

2 Select the Oracle AS node group and all managed nodes to which Oracle AS templates are 
assigned.

3 Click Remove nodes/groups.

4 Open the Node Group Bank and select the Oracle AS node group.

5 From the Action menu, select Install/Update SW & Config and check the following check 
boxes:

• Templates

• Actions
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• Monitors

• Commands

6 Select the Nodes in List option button.

7 Select the Force Update option button.

8 Click OK to remove the Templates, Actions, Commands and Monitors from the managed 
node(s). The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors

Task 3: Delete Oracle AS SPI Templates and Template Groups

Starting from the SPI for Oracle AS template group, delete all templates and template groups. 
After these templates and template groups are deleted, delete the SPI for Oracle AS template 
group. 

1 Open the Message Source Templates window and double-click the SPI for Oracle AS 
template group.

2 Press SHIFT and click to select all templates and template groups in the SPI for Oracle AS 
template group. 

3 Click Delete from All.... The following message appears:

Do you really want to delete the template(s)?

4 Click YES.

5 If additional Oracle AS SPI templates or template groups are in the SPI for Oracle AS 
template group, repeat steps 2 through 4 until you delete all Oracle AS SPI templates and 
template groups from the SPI for Oracle AS template group. 

6 Go up one level and delete the SPI for Oracle AS template group.

Task 4: Delete Oracle AS SPI Applications

Unlike templates, applications can all be removed in a single step. 

1 Open the Application Bank.

2 Right-click the OASSPI application group and click Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

If customized templates (copies of Oracle AS SPI default templates) are residing in 
other HPOM template groups, remove them as well.
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Task 5: Delete the Oracle AS SPI Message and Node groups

1 From the Window menu, select Message Group Bank.

2 In the Message Group Bank window, right-click the OASSPI group and select Delete.

3 Repeat for the Oracle AS group.

4 From the Window menu, select Node Group Bank.

5 In the Node Group Bank window, right-click each OASSPI and Oracle AS group and select 
Delete.

Task 6: Remove the Report Package (Optional)

If you installed the Oracle AS SPI report package (on your Windows system running 
Reporter), remove it:

1 On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

2 Select the Oracle AS SPI report package and click Remove.

Task 7: Remove the Graph Package (Optional)

If you installed the Oracle AS SPI graph packages (on the system running HP Performance 
Manager), remove them.

On a Windows system running HP Performance Manager, follow these steps:

1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Select the Oracle AS SPI graph package (HP OpenView SPI for Oracle Application 
Server - Graphic Component Integration) and click Remove.

On an HP-UX system running HP Performance Manager that is not the HPOM management 
server, follow these steps (if HP Performance Manager is installed on the HPOM management 
server, the files are removed in Task 1: Remove Oracle AS SPI Software from the 
Management Server on page 32):

1 Verify that the graph package is installed. Type 
swlist | grep OASSPI-GRAPHS

2 Type swremove OASSPI-GRAPHS

On a Solaris system running HP Performance Manager that is not the HPOM management 
server, follow these steps (if HP Performance Manager is installed on the HPOM management 
server, the files are removed in Task 1: Remove Oracle AS SPI Software from the 
Management Server on page 32):

1 Verify that the graph package is installed. Type 
/usr/bin/pkginfo HPOvSpiOasGc

2 Type /usr/sbin/pkgrm HPOvSpiOasGc
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3 Configuring the Oracle AS SPI 
To successfully configure the Oracle AS SPI, you must complete all configuration 
prerequisites, complete Oracle AS SPI configuration (for managed nodes and the 
management server), and complete additional configuration based on your environment.

Configuration Prerequisites

Complete the following tasks before configuring the Oracle AS SPI:

• Task 1: Configure the Management Server to Launch Your Web Browser

• Task 2: Assign Operator Responsibilities for opc_adm

• Task 3: Assign Templates to the Management Server

• Task 4: Distribute Templates to the Management Server

Task 1: Configure the Management Server to Launch Your Web Browser 

Oracle AS SPI uses the ovweb utility to start your web browser for running several Oracle AS 
SPI applications including Start Console (launch the Oracle Application Server Control 
Console), AggreSPY (launch the Oracle servlet that reports performance metrics), Repository 
(launch the Oracle Enterprise Manager Database Control used to manage the Oracle AS 
Metadata Repository database), and View Graphs (display graphed metrics, which requires 
HP Performance Manager). If you do not want to use these applications, skip this task.

1 Enter the browser invocation command in the ovweb.conf file. If no browser invocation 
command is included in the ovweb.conf file, ovweb tries to start the default web browser. 

The browser invocation command must contain a %s to enable Oracle AS SPI to pass a 
URL to the browser. Open the file and insert the command according to the entry syntax 
and example as follows:

 Syntax: Browser: <browser command> %s

2 Check the web browser setting. To display the Oracle AS SPI graphs, ensure that your 
browser is JavaScript enabled. Check the setting within the browser’s Preferences. 

3 In Task 4: Launch Discover Oracle AS on page 45, set the following conditional property:

• If you are using HP Performance Manager, set the GRAPH_URL property.

The ovweb.conf file must be located in the directory specified by the 
environment variable $OV_CONF (used by HPOM). To find the HPOM directory 
structure on your management server, open the /opt/OV/bin/ov.envvars.sh 
file and look for the $OV_CONF definition.
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For more information about launching a browser in HPOM, consult the man pages for ovweb, 
ovweb.conf, and ov.envvars. To access instructions for enabling graph displays, at a 
command prompt enter: man ovweb

Task 2: Assign Operator Responsibilities for opc_adm

1 Log on to HPOM as the administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and choose Modify.

3 In the Modify User:opc_adm user window, click Responsibilities. 

4 For OASSPI and Oracle AS Message Groups, ensure that all boxes are checked.

5 Assign the OASSPI Node or Message Groups to any other appropriate operators.

6 Click Close.

Task 3: Assign Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Assign Templates. The Define Configuration 
window opens.
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3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens.
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5 From the Message Source Templates window, in the Template Groups pane, select the 
SPI for Oracle AS template group.

6 From the Message Source Templates window, in the right pane, select the 
OASSPI-Discovery and OASSPI-Messages templates.

7 From the Add Configuration window, click Get Template Selections. The OASSPI-Discovery 
and OASSPI-Messages templates appear in the right pane.

8 From the Add Configuration window, click OK.
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Task 4: Distribute Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Install/Update SW & Config. 

3 In the Target Nodes section, select Nodes in List Requiring Update.

4  In the Install/Update Software and Configuration window, check the Templates check box.

5 Select Force Update.

6 Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates

The OASSPI-Discovery and OASSPI-Messages templates are distributed to the management 
server. 
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Oracle AS SPI Configuration on Managed Nodes

Complete the following tasks for each managed node:

• Task1: Verify the Application Server Status

• Task2: Configure a Oracle AS Server User

Task1: Verify the Application Server Status

For each managed node, verify that the application servers are running by checking a server’s 
status from the Oracle Application Server Control Console.

Task2: Configure a Oracle AS Server User

If security is enabled on the Oracle AS servers, collect the Oracle AS login and password for 
each OC4J/OHS server. If you do not want to use the existing login and password, create a 
new login and password. The Oracle AS SPI discovery process uses the login and password to 
gather basic configuration information, and the Oracle AS SPI data collector uses the login 
and password to collect metrics. 

This feature is enabled only for Oracle AS SPI version 6.10. You can use the username and 
password for users/groups assigned to the administrator or operator role.

To simplify the Oracle AS SPI configuration, keep the login and password for both OC4J and 
OHS servers similar.
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Oracle AS SPI Configuration from the Management Server

To configure Oracle AS SPI, complete the following tasks (from the management server):

• Task 1: Assign the OASSPI-Messages Template

• Task 2: Distribute Templates, Actions, Monitors, Commands

• Task 3: Add Nodes to the Oracle AS Node Group

• Task 4: Launch Discover Oracle AS

• Task 5: Verify the Discovery Process

• Task 6: Distribute Oracle AS SPI Templates to the Managed Nodes

• Task 7: Completing Configuration

• Task 8: Verify Oracle AS SPI Configuration

Task 1: Assign the OASSPI-Messages Template

1 Open the Node Bank window and select the managed nodes.

2 From the Actions menu, select Agents  Assign Templates. The Define Configuration 
window opens.
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3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 Select the SPI for Oracle AS template group.

6 In the right pane, select the OASSPI-Messages template.
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7 In the Add Configuration window, click Get Template Selections. The OASSPI-Messages 
template appears in the right pane.

8 Click OK.

Task 2: Distribute Templates, Actions, Monitors, Commands

1 Select the node(s) on which to install the Oracle AS SPI.

2 From the Node Bank’s Actions menu select Agents  Install/Update SW & Config. 

3  In the Install/Update HPOM Software and Configuration window, select the following 
component check boxes:

• Templates

• Actions

• Monitors

• Commands
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Using this dialog, deploy program components to the managed nodes. 

4 Select the Force Update check box.

5 Select the Nodes in list option button. Click OK. 
Upon completion, the following message appears in the Message Browser for each 
managed node:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors

The Oracle AS SPI is now installed on the selected managed node(s). 

Task 3: Add Nodes to the Oracle AS Node Group

Oracle AS SPI automatically creates a single node group (Oracle AS) with appropriate 
template groups already assigned. Place any nodes running Oracle OC4J/OHS servers in this 
node group.

1 From the HPOM console, open both the Node Group Bank and the Node Bank to display 
(side-by-side) the Oracle AS node group and the managed nodes.

2 Drag and drop managed nodes running Oracle OC4J/OHS servers into the Oracle AS node 
group. 
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Task 4: Launch Discover Oracle AS

Launch the Discovery application on one managed node at a time.You must run the Discover 
Oracle AS tool to set the basic configuration properties required for the Oracle AS SPI to 
discover instances of the Oracle Application Server, deploy the Oracle AS SPI discovery 
templates, and update the service map. 

Follow these steps: 

1 At the HPOM console, double-click OVO Node Bank. The OVO Node Bank window opens. 

2 From the Window menu, select Application Bank. The OVO Application Bank opens in a 
new window.

3 Double-click OASSPI. The Application Group: OASSPI window opens.

4 Double-click OASSPI Admin. The Application Group: OASSPI Admin window opens. All 
the OASSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Discover Oracle AS (If the 
above does not appear as described, select Map  Reload.) The Introduction window opens. 
This window contains brief information about the Discovery application.

6 Click Next. A second Introduction window opens. This window displays information about 
the properties that might be required for the discovery process to work.

7 Click Next. If you already set the LOGIN and PASSWORD properties, the configuration 
editor opens.

If you did not set the LOGIN and PASSWORD properties, the Set Access Info for Default 
Properties window opens.

8 Set the same LOGIN and PASSWORD properties as configured in the Oracle AS login 
and password in Task2: Configure a Oracle AS Server User on page 40. 

9 Click Next. The configuration editor opens.

10 From the configuration editor, set the configuration properties. For more information 
about using the configuration editor, see Appendix B, The Configuration.

11 Click Next to save any changes and exit the editor.

12 The Confirm Operation window opens. Verify the nodes on which the operation is to be 
performed. Click OK.

If an instance of Oracle AS has a server login name and password different from the default 
login and password, before launching the discovery tool you must explicitly configure the 
login details for that server using the configuration editor.

The LOGIN and PASSWORD properties set in this window are used as the default 
Oracle AS login and password (they are set at the global properties level). That is, 
if no NODE level or server-specific LOGIN and PASSWORD properties are set, 
this Oracle AS login and password are used by the Oracle AS SPI to access all 
Oracle AS servers. For more information about the configuration structure, see 
Structure on page 129.

If you click Cancel and made changes to the configuration, those changes remain in 
the configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, start the Discover Oracle AS application, click Next from the configuration 
editor, and then click OK.
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JMX Discovery for Oracle AS

Oracle AS SPI now supports JMX discovery for Oracle Application Server version 10gR3. 

In your environment you may have different versions of Oracle Application Servers, for 
example, version 10gR3 or older, installed on the same node. In such a scenario, you may have 
to select whether you want to run classic discovery or the JMX discovery.  

There can be three scenarios:

Scenario 1: If only Oracle Application Server version 10gR3 is installed on the node.

By default, the JMX Discovery runs.

Scenario 2: If Oracle Application Server versions older than 10gR3 (for example10gR1 and 10gR2) 
are installed on the node. 

By default, the classic system of discovery runs.

Scenario 3: If different versions of Oracle Application Server (10gR3 along with 10gR1 or 10gR2) are 
installed on the node. 

You can choose the method of discovery.

In the SPIConfig file, set the value of the JMX_DISCOVERY flag to true or false. By default, 
the value is true.

• If JMX_DISCOVERY=true, the JMX Discovery runs for Oracle AS 10gR3 version only and 
all the older versions are not discovered.

• If JMX_DISCOVERY=false, the classic system of discovery is used for all the versions 
including 10gR3.

Discovering HTTP (OHS) Server

There can be two discovery scenarios for HTTP (OHS) servers:

Scenario 1: HTTP (OHS) and OC4J servers are on the same system and have a common Oracle HOME.

The HTTP server is automatically discovered.

Scenario 2: HTTP (OHS) and OC4J servers are on different systems and /or have different Oracle 
HOME.

Follow these steps:

1 In the cluster, identify the OC4J instance that is connected to the OHS server. 

For the older versions of Oracle Application Servers, Oracle AS SPI uses DMS tool for 
Discovery. This is referred to as classic discovery in this document.

If you set the JMX_DISCOVERY flag to false, the collection of JMX Metrics (belonging to the 
OASSPI-Metrics (JMX) template group) fails. All metrics belonging to the OASSPI Metrics 
group is collected with the exception of OASSPI_0001, OASSPI_0002, OASSPI_0005, and 
OASSPI_0245.

The new JMX discovery discovers the HTTP server only if it is a part of a cluster.
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2 In the Configuration Editor (see Using the Configuration Editor on page 131 for more 
information about the configuration editor) right-click the node on which the OC4J server 
is installed and select Add OC4J/OHS Server. The OASSPI Discover Tool: Add App Server 
window opens.

3 Select the HTTP Server checkbox and click OK. The HTTP Server is added below the OC4J 
server. 

4 Select the HTTP Server. In the Properties for OC4J/OHS Server: HTTP Server pane, the 
NAME and TYPE  properties appear by default. 

5 Clear the Auto Discovery checkbox and set the following properties—to set a property 
select the property from the Select a Property to Set dropdown menu and click Set 
Property. Double-click the empty space next to the property after the property appears in 
the list.:

— HOME: Similar to the value set for the OC4J server. 
For example: E:/product/10.1.3.1/OracleAS_1

— JAVA_HOME: Similar to the value set for the OC4J server.
For example: E:/product/10.1.3.1/OracleAS_1/jdk

— LOGIN: Similar to the value set for the OC4J server.

— PASSWORD: Similar to the value set for the OC4J server.

— MAP_KEY_PREFIX: Any unique HTTP instance name

— URL_PATH: Similar to the value set for the OC4J server. However, you must replace 
/home at the end of the URL with /cluster.
For example: /optmn://testsystem.com:6004/cluster

To get the port no. in the URL, type the following command from the command 
prompt: <directory> /product/10.1.3/OracleAS_1/opmn/bin> opmnctl 
status –port.

— VERSION: 10.1 3

Note that there is a single space between 10.1 and 3 in the version.

6 Click Next. The OASSPI Discover Tool: Confirm Operation Window opens.

7 Click OK.

Task 5: Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification takes several 
minutes to complete.

1 Verify that the following messages appear in the Discover Oracle AS application window 
(the Discover Oracle AS application completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

There are two limitations in this scenario:

1 You must manually enter the information the SPI requires to monitor the HTTP server.
2 The information about the HTTP Server does not appear in the service map because this 

information was manually entered and not discovered.
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If the Discover Oracle AS application does not complete successfully, the following 
message appears in the application window:

Failed to run discovery on node <node>

See Troubleshooting the Discovery Process on page 90 for information on how to 
troubleshoot the discovery process.

2 Verify that the following message appears in the message browser for each managed node:

WASSPI-602 - Updating the OASSPI configuration data with discovered 
information

Depending on the number of managed nodes in your environment, it might take several 
minutes for these messages to display for all managed nodes.

3 If Service Navigator is already running, select File  Reload Configurations. In the Services 
tree, open the Application node and look for the Oracle service. 

4 Run the Configure OASSPI application to verify the properties set by the discovery 
process. For more information about the configuration editor, see Configure OASSPI on 
page 150.

Task 6: Distribute Oracle AS SPI Templates to the Managed Nodes

1 Open the Node Group Bank window and select the Oracle AS node group.

2 From the Actions menu, select Agents  Install/Update SW & Config. 

3 In the Target Nodes section select the Nodes in List Requiring Update option button.

4  In the Install/Update Software and Configuration window check the Templates check box.

5 Select Force Update.

6 Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates

The Oracle AS SPI templates are now distributed to the Oracle AS node group.  Oracle AS SPI 
monitors can now begin running according to their specific collection interval.

Task 7: Completing Configuration 

Before configuration is complete, the configuration information on the management server 
and managed nodes must be updated. You can either:

• Run the Configure OASSPI application (which updates the configuration information on 
the management server and managed nodes). For more information, see Configure 
OASSPI on page 150. This method is recommended.

Or

• Wait at least 10 minutes for the automatic configuration template to run.

If you use HP Reporter, see Chapter 5, Integrating HPOM Reporting and Graphing Products 
with the Oracle AS SPI, for information on integrating Oracle AS SPI with Reporter. Use 
Reporter to generate Oracle Application Server reports that show more consolidated 
information.
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Task 8: Verify Oracle AS SPI Configuration

Run the Verify application to verify that Oracle AS SPI is properly installed and configured. 
For more information about this application, see Verify on page 156.

1 At the HPOM console, select the Oracle AS node group in the Node Group Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin and double-click Verify. 

Additional Oracle AS SPI Configuration

Based on your Oracle Application Server configuration and application needs, you must finish 
Oracle AS SPI configuration by setting additional configuration properties and/or installing 
and configuring additional components. Setting additional properties and configuring 
additional components depends on your environment.

Conditional Properties

Based on your Oracle Application Server configuration and application needs, you might need 
to set one or more conditional properties. If you meet a condition, set the properties listed to 
the right of the condition (these properties are not automatically discovered by the discovery 
process). For more information about the properties, see Configuration Properties on 
page 139.

Setting Conditional Properties

1  At the HPOM console, select the node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Configure OASSPI.
(If the above does not appear as described, select Map  Reload.)

The Introduction window opens. This window contains brief information about the 
Discover Oracle AS application.

4 Click Next. The configuration editor opens.

5 From the configuration editor, set the properties. For more information about using the 
configuration editor, see Appendix B, The Configuration.

6 Click Next to save any changes and exit the editor. The Confirm Operation window opens.

Table 1 Conditional Properties

Condition Property to Set

Start or stop an Oracle Application Server using the Start/
Stop Oracle AS application from the HPOM console.

START_CMD, STOP_CMD, 
and USER

Use the View Graphs application from the HPOM console 
(Performance Manager must be installed).

GRAPH_URL
Configuring the Oracle AS SPI 49



7 Click OK.

Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x 
Only)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node 
(OVO 8.x only), follow these steps:

1 Switch the HTTPS agent to a non-root user. For more information, see the HP Operations 
Manager HTTPS Agent Concepts and Configuration Guide. This document is available at 
http://ovweb.external.hp.com/lpe/doc_serv/ under the product Operations for UNIX, 
version 8.x.

2 Add the  agent user account to the local Oracle Application Server user group on the 
managed node. This enables the HP Operations agent user access to the files in the Oracle 
Application Server installation directories. Use the system administration tool or modify 
the /etc/group file to add the user.

3 On the managed node, set the OV_SUDO variable. As root or with HP Operations agent 
user privileges, follow these steps:

a Stop all HP Operations agents. Run the following command:

opcagt -kill

b Set the OV_SUDO variable. Run the following command:

ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

where <sudo_program> is the location (including the absolute pathname) where sudo 
is installed (for example, /usr/local/bin/sudo).

c Start the HP Operations agents. Run the following command:

opcagt -start

d Verify OV_SUDO is set. Run the following command:

ovdeploy -cmd set | grep SUDO

The following displayed:

OV_SUDO=<sudo_program>

4 Configure the managed node. These steps MUST be completed to successfully run the SPI 
in a non-root HTTPS agent environment. 

a From the HPOM management server, deploy actions, commands, and monitors to the 
managed node.

b Select the node in the Node Bank window. 

If you click Cancel and make changes to the configuration, those changes remain in 
the configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, start the Configure OASSPI application, click Next from the configuration 
editor, and then click OK.

You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo 
is free software available from http://www.sudo.ws. The OS-dependent software packages 
are located at the bottom of the download page (http://www.sudo.ws/sudo/download.html). 
See the release notes for more installation information.
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c From the Application Bank window, select OASSPI  OASSPI Admin  Init Non-Root.

5 Edit the /etc/sudoers file using the visudo editor (installed with sudo):

a On the managed node, log in as root.

b Open the /<SPI_Config_DIR>/wasspi_oas_sudoers file

where <SPI_Config_DIR> is the location of the SPI’s configuration files on a managed 
node. For more information, see Managed Node File Locations on page 127.

6 In a separate window, run the visudo command (for example, type: 
/usr/local/sbin/visudo).

c From the wasspi_oas_sudoers file, copy and append the following lines to the 
sudoers file:

Cmnd_Alias OASSPI_ADMN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_admin *
Cmnd_Alias OASSPI_COLL = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_ca *
Cmnd_Alias OASSPI_DISC = /opt/OV/nonOV/perl/a/bin/perl \
wasspi_oas_discovery.pl
Cmnd_Alias OASSPI_LFEN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_le *
Cmnd_Alias OASSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -S \
shs_collector.pl *

Cmnd_Alias OASSPI_ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_admin *
Cmnd_Alias OASSPI_COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_ca *
Cmnd_Alias OASSPI_DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/OV/bin/instrumentation/wasspi_oas_discovery.pl
Cmnd_Alias OASSPI_LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_le *
Cmnd_Alias OASSPI_SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs_collector.pl *
<OV_Agent_username> <nodename> = NOPASSWD: OASSPI_ADMN, \
OASSPI_COLL, OASSPI_DISC, OASSPI_LFEN, OASSPI_SHSC, \
OASSPI_ADMNP, OASSPI_COLLP, OASSPI_DISCP, OASSPI_LFENP, \
OASSPI_SHSCP

In this instance, <OV_Agent_username> is the HP Operations agent user account and 
<nodename> is the name of the managed node.

d Save the file and exit the visudo editor. Type :wq 

Steps 3 and 4 must be performed every time the agent user is switched.
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4 Customizing the Oracle AS SPI Templates
As you become familiar with the Oracle AS SPI, you can determine which templates are most 
useful to you and which you might want to change. This chapter provides more detail on the 
templates and how to make those changes. 

Basic Template Customizations

After you begin using the Oracle AS SPI, you might decide that specific Oracle AS SPI 
templates need some modification. Basic customizations, such as changing a threshold (by 
modifying a metrics template) or modifying alarm generation, are covered in this section.

Modifying Metrics Templates

Many metric attributes can be modified for all monitored instances of Oracle OC4J/OHS 
servers by following these steps: 

1 Open the Message Source Templates window.

2 Open the SPI for Oracle AS template group.

3 Open the OASSPI-Metrics template group.

4 Double-click the desired metric which opens the Message and Suppress Conditions 
window.

5 Double-click the desired condition to modify (there can be more than one). The Condition 
window opens.

Make copies of the default templates so that they remain intact. Otherwise, your 
customizations are overwritten when you upgrade to the next version. 
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You can modify the following attributes through this window:

— Threshold. Enter a value for the metric data that, when exceeded, would signify a 
problem either about to occur or already occurring. 

— Duration. The length of time that the established threshold can be exceeded by the 
incoming data values for a metric before an alarm is generated.

— Severity. The level assigned by the HPOM administrator to a message, based on its 
importance in a given operator’s environment. Click Severity to select the desired 
severity setting.

— Message Text. Structured, readable piece of information about the status of a 
managed object, an event related to a managed object, or a problem with a managed 
object. Be careful not to modify any of the parameters—surrounded by <> brackets, 
beginning with $—in a message.

— Actions. Response to a message that is assigned by a message source template or 
condition. This response can be automatic or operator-initiated. This section provides 
the ability to generate Performance Manager graphs or reports, or to add custom 
programs. 
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— Automatic action. Action triggered by an incoming event or message. No operator 
intervention is involved. The automatic action delivered with the Oracle AS SPI 
generates a snapshot report that shows the data values at the time the action was 
triggered from an exceeded threshold. You can view the report in the message 
Annotations.

— Operator-initiated action. Action used to take corrective or preventive actions in 
response to a given message. Unlike automatic actions, these actions are triggered 
only when an operator clicks a button. The operator-initiated action delivered with 
the Oracle AS SPI enables you to view a graph of the metric whose exceeded threshold 
generated the message along with other related metric values (click Perform Action 
within a message’s details window).

The following illustration of the Condition window shows a threshold setting of 95 for 
metric OASSPI-0005. This metric monitors the percentage of heap space used in the 
JVM. A value of more than 95 (but less than 98) for 20 minutes would generate an 
alarm (a message of the severity major).

6 Click OK.

7 Re-distribute the modified template as described in Task 6: Distribute Oracle AS SPI 
Templates to the Managed Nodes on page 48.

Modifying Alarm Generation

An alarm can be generated once or multiple times, depending on its Message Generation 
setting in the Modify Threshold Monitor window. 

To change the Message Generation, follow these steps:

1 Open the Message Source Templates window. 

2 Open the SPI for Oracle AS template group.

3 Open the OASSPI-Metrics template group.

4 Select the template.
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5 Click Modify. The Modify Threshold Monitor window opens. 

6 Modify the Message Generation:

• With Reset: Alarms are generated once when the threshold value is exceeded. At the 
same time a reset threshold value is activated. The original threshold value becomes 
active again only when the reset threshold value is exceeded. Then when the 
threshold value is again exceeded, another alarm is generated and the process starts 
all over again.

• Without Reset. Alarms are generated once when the monitoring threshold value is 
exceeded. Alarms reset automatically when metric values are no longer in violation of 
the thresholds and are generated again when the threshold is exceeded.

• Continuously. Messages are sent/alerts generated each time the metric values are 
collected and the threshold is exceeded. 

7 Click OK.

8 Re-distribute the modified templates as described in Task 6: Distribute Oracle AS SPI 
Templates to the Managed Nodes on page 48.

Advanced Template Customizations

The template changes suggested here range from making copies of default template groups in 
order to customize a few settings, to deleting whole groups of metrics within a template’s 
command line. This section is considered advanced because all changes described here, 
whether simple or complex, require some advanced knowledge of the Oracle AS SPI metrics.
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Choosing Metrics To Customize

Determine which metrics you want to customize and what templates within the group you 
want to use. Then, follow these steps:

1 Open the Message Source Template window.

2 Select the group you want to use and click Copy....

3 Rename and save the group.

4 Within the renamed template group, copy each original template and rename it. 

5 Delete the originals within the renamed template group.

6 Customize the renamed templates within the group as necessary. 

Creating a new template group enables you to keep custom templates separate from the 
original default templates, which you copy and place within the new group. 

Using the Oracle AS SPI Collector/Analyzer Command with Parameters

The wasspi_oas_ca command is used in every collector template, named according to its 
collection interval. You can view the default command line parameters within each collector 
template in the Command box in the Modify Scheduled Action window. 

Using the Collector Command Parameters

Oracle AS SPI data collections are started with the wasspi_oas_ca command, to which you 
can add other parameters, as identified in the following table.

Parameter Function Syntax with Example

-e (exclude) Enables you to 
exclude specific servers. This 
option must not be used with 
the -i option.

-e <server_name>
Example: -e server2,server4

-i (include) Enables you to list 
specific servers to monitor. 
This option must not be used 
with the -e option.

-i <server_name>
Example: -i server1,server3

-m (metric) Specifies the metric 
numbers or number ranges 
on which to collect data.

-m <metric_number|metric_number_range>
Example: -m 1,3-5,9-11,15

-matchver (match version) Specifies the 
specific Oracle OC4J/OHS 
server version to monitor. 
This option must not be used 
with the -minver nor 
-maxver options. If no 
matching versions are found, 
the command does not start.

-matchver <version_number>
Example: -matchver 10.1.2
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Syntax Examples

• To collect specific data on all configured servers:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0

• To collect data from specific servers only:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0 -i server1,server2

-maxver (maximum version) Specifies 
the highest Oracle OC4J/
OHS server version to 
monitor. Use with -minver to 
specify a range of versions. If 
no versions are found, the 
command does not start. 

-maxver <version_number>
Example: -maxver 10.1.2

-minver (minimum version) Specifies 
the lowest Oracle OC4J/OHS 
server version to monitor. 
Use with -maxver to specify 
a range of versions. If no 
versions are found, the 
command does not start.

-minver <version_number>
Example: -minver 10.1.2

-r (report) Generates an ASCII 
report for the specified 
metric(s).

-r

-t (tag) Creates a new template 
group by adding a prefix to 
an existing collector template 
and specifying the metric 
number(s). 

-t <prefix>-
Example: wasspi_oas_ca -m 220-223 -t 
DEV-

-x Enables you to specify a 
property/value as follows:

-x <property>=<property_value>

alarm: When off, overrides 
any alarming condition as set 
up in the metric monitor 
template.

-x alarm=off

prefix: Default: JMXUDM_. 
Specifies the prefix of the 
metric ID.

-x prefix=SALES_

print: When on, prints the 
metric name, instance name, 
and metric value to STDOUT 
in addition to any configured 
alarming or logging.

-x print=on

log: When off, prevents 
graphing or reporting 
functions.

-x log=off

Parameter Function Syntax with Example
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• To not collect data from specific servers:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0 -e server1,server2

Changing the Collection Interval for All Metrics

To change the collection interval for all scheduled metrics, change the Polling Interval in the 
appropriate collector template. For example, to change the collection of default metrics from 5 
minutes to 10 minutes for the OASSPI-10-OHS-05min collector template, follow these steps:

1 Select the Message Source Templates window.

2 Select the template group SPI for Oracle AS and open OASSPI-Schedule.

3 Select the collector template OASSPI-OHS-05min.

4 Click Modify... and change the Scheduled Action Name to OASSPI-OHS-10min.

5 Change the polling interval from 5 minutes to 10 minutes. For example, 0, 10, 20....

6 Distribute the new templates (described in Task 6: Distribute Oracle AS SPI Templates to 
the Managed Nodes on page 48). 

Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template 
and rename with a name reflecting the new interval, deleting all but the metrics you are 
changing. Set the new interval. Edit the original template to remove the changing metrics. 
For example, to change the collection interval to 10 minutes for metrics 10 and 11, you would 
follow these steps:

1 Open the Message Source Templates window.

2 Select the template group SPI for Oracle AS and open OASSPI-Schedule.

3 Select the schedule template OASSPI-OHS-05min.

4 Click Copy... and change the name of the schedule template to OASSPI-OHS-10min.

5 In the Command box, delete all metrics after -m except 10 and 11.

6 Change the polling interval to 10 minutes.

7 Click OK.

8 Select the OASSPI-OHS-05min template.

9 Delete 10, 11 from the Command box.

10 Re-distribute the modified templates as described in Task 6: Distribute Oracle AS SPI 
Templates to the Managed Nodes on page 48.
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Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you might want to set the threshold to 90 for 
SERVER_1 for metric 0220 and leave the threshold at 100 for all other servers. To do so, copy 
the existing condition and modify it to serve as the exception. Follow these steps:

1 Double-click to open the metric for customization (for example, OASSPI-0220). 

The Message and Suppress Conditions window is displayed. 

2 Select the desired condition and click Copy... to make a copy of the condition. 

3 Name the condition OASSPI-0220.2. 

4 In the Object Pattern field, enter the following details:

<ServerName>:<ServerPort>:<NodeName>:<*>:<*>:<*>

For Example: If you want to set threshold for the application server SERVER1, enter the 
following:

SERVER1:<*>:<*>:<*>:<*>:<*>

5 Click the Test Pattern Matching… to test the pattern and verify pattern matching (you must 
set up a match file first).

6 Change the value in the Threshold field from 100 to 90.

Creating Custom, Tagged Templates 

Another advanced customization option is to use the tag option (-t on the command line), 
which enables the collector/analyzer to recognize customized templates that have a tag 
attached to the name. This option provides you with the flexibility of using more than a single 
set of templates to define conditions pertaining to specific installations of Oracle Application 
Server.

When multiple nodes are managed by a number of groups, this option enables you to create 
specially tagged templates that are obviously separate from your original setup. In such a 
case, you would make copies of the templates, rename them with the tag and re-work the 
collector template to pick up the tagged names, and then assign them to the various groups. 

For example, you can create a group of templates and change each template name to include 
CLIENT01 in it. A metric monitor template can be named CLIENT01-OASSPI_0001 
(retaining the metric number, which must be used). The collector template name would be 
named FIRST_CLIENT-OHS-05min. You could then set up another group for 
SECOND_CLIENT and change all those templates to include the CLIENT02 in the name.

To create the new template group, follow these steps:

1 Copy the original template group. In the Message Source Templates window select the 
group and click Copy....

2 Name the new group according to how you plan to identify the new schedule and collector 
templates. For example, if you are including CLIENT01 in the template names, include it 
within the new template group name.

3 In the Message Source Template window, expand the new template group to show all 
templates and select each template you plan to use, click Copy..., and rename it according 
to your naming scheme. 
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• The names you give the new metric monitor templates in the group would contain the 
new name followed by the original metric number. For example, a copy of 
OASSPI-0001 could be called CLIENT01-OASSPI_0001.

• The name you give the new collector monitor template would also contain the 
identifying name. You would also modify the scheduled collection for the new group by 
inserting the -t property on the command line. For example: 

wasspi_oas_ca -m 1 -t CLIENT01-

4 Delete all original templates from the new group.

Template Variables

The following variables are used by the Oracle AS SPI templates. If you are creating your own 
templates, you can use these variables.

Name Description

instancename The instance for which the metric is being reported for 
multi-instance metrics.
Example: /oc4j/Petstore/EJBs/shoppingcartEjb.jar/
TheCart/ejbActivate

node The node on which the OC4J/OHS server is running.
Example: moo1.hp.com

servername The OC4J/OHS server name. Corresponds to the NAME 
configuration property.
Example: my server

service_key The service ID used to light up the nodes in the service map.
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Re-install the Oracle AS SPI Templates

When Oracle AS SPI templates are installed in HPOM, the following commands 
automatically upload them when swinstall is run. Any customized template settings you did 
for the previous installation are overwritten. 

To restore the default SPI for Oracle AS template group you had originally installed, delete all 
current templates first, then run the command:

/opt/OV/bin/OpC/opccfgupld -silent -replace 
-subentity /var/opt/OV/share/tmp/OpC_appl/wasspi/oas/oas_set

Alternatively, you can use the -verbose option instead of the -silent option.

Use Templates/Applications to View Annotation Reports and 
Graphs

Some templates have actions defined with threshold violations or error conditions that 
automatically cause reports to appear in the message Annotations. These reports are 
snapshots of data values collected form the server around the time that the alarm occurred.

Other templates have operator actions associated with them that enable you to generate a 
graph. 

You can access the data as follows:

• To view the Message Details, double-click a message in the HPOM message browser, or 
just select the message and click Annotations. You can easily access Annotations by 
clicking  Annotations. Reports are available there, showing data values on a single server. 

• To view reports, open both the Node Bank and Application Bank windows. Continue to 
open application windows OASSPI  OASSPI Admin  Reports. Select a node and drag it 
onto the OASSPI metric report you need. These reports show all server data on a node. 

• To view graphs, open both the Node Bank and Application Bank windows. Continue to 
open application windows OASSPI  OASSPI Admin. Drag a node onto the View Graphs 
application to launch your web browser, which opens the graphing feature available in HP 
Performance Manager (which must be purchased separately).

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports are generated as soon as an 
alarm is triggered in HPOM. Automatic Action reports show the state of the system moments 
after the alarm occurred. 

The reports discussed in this section should not be confused with those generated by HP 
Reporter, which show more consolidated, historical data generated as web pages in 
management-ready presentation format.
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Viewing an Automatic Action Report

When an Automatic Action Report is run from HPOM, the server is queried for additional 
data. If your message browser is set to display the SUIAONE columns, You will see  an S 
under the A column (see illustration), which indicates that a generated report is available in 
the Annotations area of the Message Details.

To view the report, click Annotations... in the Message Browser. Column descriptions provide 
further clarification.

Application Bank Reports

You can use Application Bank Reports to manually generate a report similar to an Automatic 
Action report.

Application Bank reports run for all Oracle OC4J/OHS server instances configured on the 
managed node, in contrast to Automatic Action Reports which are generated for a single 
Oracle OC4J/OHS server instance. The reports generated from the Application Bank reflect 
the current state of Oracle OC4J/OHS server on the managed node.  
Customizing the Oracle AS SPI Templates 63



To generate a report in HPOM, simply drag the managed node from the Node Bank window to 
the desired report in the Application Bank window.
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The following report appears in the Annotations area of the message details.
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Sample Report

The following example shows the format of a Oracle AS SPI report. This report is 
automatically generated (automatic action report) for metric C280.
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Check Oracle AS SPI Nodes for License Count

You can use an HPOM reporting utility to check the number of templates you installed on 
your managed nodes. In reviewing the number of templates per managed node, you can see if 
you consistently installed templates across your managed systems. In addition, by running 
this report, you can also ensure that the number of licenses you purchased is in compliance 
with the report results.

To run the report:

1 At the HPOM console, select the node or node group that you want to check.

2 From the Actions menu select Utilities  Reports....

3 In the Reports window, among the reports listed, select OASSPI License Check.

4 Select an output destination and click OK.
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5  Integrating HPOM Reporting and Graphing 
Products with the Oracle AS SPI
The Oracle AS SPI can be integrated with the following HP reporting and graphing products. 
These products must be purchased separately.

• HP Reporter. Reporter produces management-ready, web page reports, showing 
historical and trending information. This is not the version of Reporter that is included 
with HP Operations Manager. 

Working in conjunction with Reporter, the Oracle AS SPI produces a variety of reports 
showing consolidated information on the Oracle Application Server.

For more information on how to integrate Oracle AS SPI with HP Reporter, see 
Integrating with HP Reporter on page 70. After integrating Oracle AS SPI with Reporter, 
every night, Reporter generates reports that show the performance and availability of an 
Oracle Application Server on configured managed nodes.

• HP Performance Agent. HP Performance Agent collects, summarizes, time stamps, and 
detects alarm conditions on current and historical resource data across your system. It 
provides performance, resource, and end-to-end transaction response time measurements, 
and supports network and database measurement information. For more information 
about HP Performance Agent, see the HP Performance Agent for UNIX User’s Manual. 

• HP Performance Manager. HP Performance Manager provides graphing capability of 
Oracle AS SPI metrics.

For more information on how to integrate Oracle AS SPI with HP Performance Manager, 
see Integrating with HP Performance Manager on page 72. After integrating Oracle AS 
SPI with HP Performance Manager, graphs are available the following day. 

Integrating with CODA

The Oracle AS SPI can detect if you are using HP Performance Agent. If you are, the Oracle 
AS SPI installation automatically uses it. 

If you want to use the HP Operations subagent (CODA) included with OVO for UNIX 8.28, 
8.29, and 8.30, you must configure the managed nodes to do so. Note that there are no 
advantages to using CODA instead of HP Performance Agent. 

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda.opt file in the following directory:

Operating System File Location

HP-UX, Linux, Solaris /var/opt/OV/conf/dsi2ddf/ 

AIX /usr/lpp/OV/conf/dsi2ddf/

Windows \usr\ov\conf\dsi2ddf\ 
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If the directory dsi2ddf does not exist, create it.

2 Save the empty file.

Integrating with HP Reporter

The Oracle AS SPI must be configured (see Chapter 3, Configuring the Oracle AS SPI) before 
it can be integrated with Reporter.

The Oracle AS SPI report package must be installed on the Windows system running 
Reporter: 

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the 
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:

\OV_REPORTER\OracleAS_SPI_06.00.000\OASSPI-Reporter-06.00.000.msi

2 Follow the instructions as they appear.

3 Check the Reporter status pane (see the illustration that follows) to note changes to the 
Reporter configuration. 

The status pane (at the bottom of the Reporter window) shows you information on the 
programs running and any errors occurring. You can check the status pane to see that 
Reporter has been updated with the Oracle AS SPI reports. 

You can find instructions in the Reporter Help for assigning Oracle AS SPI reports to the 
targeted nodes. To access Help, select Reports or Discovered Systems in the left panel of 
the Reporter main window and right-click. Select Report Help or Discovered Systems 
Help from the submenu that appears. See the topic “To assign a report definition to a 
Discovered Systems Group.”

4 Add group and single system reports by assigning reports as desired. (See the Reporter 
Help and the online Concepts Guide for complete information.)

Oracle AS SPI Reports

The reports available through the integration of HP Reporter and Oracle AS SPI show 
consolidated data on server performance and availability on Oracle Application Server 
systems. These reports are available the day following your installation of the Oracle AS SPI 
report package on the Reporter Windows system. (See Integrating with HP Reporter on 
page 70 if you did not complete the report package installation.)

For Windows 2000 managed nodes, during the installation an error message might appear 
that indicates the installer has detected an older version of the installer on your system. You 
can safely ignore the message and continue.

Group and single system Oracle AS SPI reports require that you identify systems by their full 
name. For example, abc.xyz.com is acceptable while abc is not.
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The tables that follow show all pre-defined reports for groups (one or more managed nodes on 
which an Oracle Application Server is installed) and single systems. 

Table 2 Group Reports

Title Description

Oracle 
AS 
Version Metric

Availability The percentage of up time of all Oracle 
Application Servers by day

9.04, 
10.1.2, 
10.1.3

2

EJB Method Calls Process 
Rate - Top 20

The number of all EJB method calls 
processed per minute for the top 20 OC4J 
servers

9.04, 
10.1.2, 
10.1.3

22

Servlet Active Threads - Top 
20

The number of servlet active threads for 
the top 20 OC4J servers

9.04, 
10.1.2, 
10.1.3

42

Servlet Average Execution 
Time - Top 20

The servlet average execution time for 
the top 20 OC4J servers

9.04, 
10.1.2, 
10.1.3

240

Table 3 Single System Reports

Title Description

Oracle 
AS 
Version Metric

HTTP Server and OC4J 
Availability Details

The percentage of hourly up time per day 
during the reporting period

9.04, 
10.1.2, 
10.1.3

2

HTTP Server and OC4J 
System Resource Utilization

The hourly average of the percentage of 
CPU utilization and the percentage of 
system memory utilization per day 
during the reporting period

9.04, 
10.1.2, 
10.1.3

10, 11

HTTP Server Connections The average number of HTTP server 
connections per day for each application 
server on the selected system

9.04, 
10.1.2, 
10.1.3

100

DB Connection Cache 
Utilization

The hourly average of the percentage of 
database connection cache utilization per 
day during the reporting period

9.04, 
10.1.2, 
10.1.3

260

OC4J WebContext Sessions The average number of WebContext 
sessions per day for each OC4J instance

9.04, 
10.1.2, 
10.1.3

281
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Integrating with HP Performance Manager

To integrate Oracle AS SPI with HP Performance Manager, follow these steps:

1 Install and configure the Oracle AS SPI. Verify that you completed Task 1: Configure the 
Management Server to Launch Your Web Browser on page 35. Also, verify that you set the 
GRAPH_URL property. For more information about the GRAPH_URL property, see 
Property Definitions on page 141.

2 If you are upgrading the Oracle AS SPI graph package, remove the old version before 
installing the new version. For information on removing the Oracle AS SPI graph package 
see Task 14: Install the New Graph Package (Optional) on page 31.

3 Install the graph package.

On a Windows system running HP Performance Manager, follow these steps:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the 
DVD-ROM drive, and in Windows Explorer, double-click:

\OV_PM\OracleAS_SPI_06.00.000\WINDOWS\HPOvSpiOasGc-06.00.000.msi

b Follow the instructions as they appear.

On an HP-UX system running HP Performance Manager that is not the HPOM 
management server, follow these steps (if HP Performance Manager is installed on the 
HPOM management server, the files are already installed using the swinstall 
command):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

swinstall -s <mount_point>/OV_PM/OracleAS_SPI_06.00.000/HPUX/
HPOvSpiOasGc-06.00.000.depot OASSPI-GRAPHS

On a Solaris system running HP Performance Manager that is not the HPOM 
management server, follow these steps (if HP Performance Manager is installed on the 
HPOM management server, the files are already installed):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/OracleAS_SPI_06.00.000/
SOLARIS/HPOvSpiOasGc-06.00.000.sparc all

4 To graph any Oracle Application Server metric, use the data source name 
OASSPI_METRICS

See the HP Performance Manager documentation for information on how to view the graphs. 
Graphs are available the day following integration.

Allow sufficient collection intervals to occur before attempting to view graphs (using HP 
Performance Manager).

Data Source Description

Metrics collected by the Oracle AS SPI are stored in the data sources named 
OASSPI_METRICS and OASSPI_RPT_METRICS. The values can be viewed for trend analysis.

Class OASSPI_METRICS
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Column Attribute

1 C005_JVMMEMUTILPCT

2 C010_CPUUTILPCT

3 C011_MEMORYUTILPCT

4 C012_CPUUTILPCTHTTP (for OAS version 10gR3 only)

5 C014_THREADPOOLUTIL (for OAS version 10gR3 only)

6 C015_THRDPOOLWAITCNT (for OAS version 10gR3 only)

7 C100_HTTPSVRACTCONN

8 C108_HTTPAVGRESPSZRQ

9 C109_HTTPVHAVRSPSZRQ

10 C020_EJBCLACTTHREADS

11 C021_EJBCLAVGEXECTIM

12 C022_EJBCLCALLSPRCRT

13 C030_EJBWRAPACTTHRDS

14 C031_EJBWRPAVEXECTIM

15 C032_EJBWRPCALLPRCRT

16 J233_STLESSSNBNPLUTL (for OAS version 10gR3 only)

17 J234_STFULSSNBNPLUTL (for OAS version 10gR3 only)

18 J235_ENTITYBNPLUTL  (for OAS version 10gR3 only)

19 C042_SRVLTACTTHREADS

20 C047_JSPACTREQUESTS

21 C050_JMSCONNCREATED

22 C280_WEBCNTXTAVRQPRC

23 C281_WEBCNTXTACTSESS

Class OASSPI_RPT_METRICS

Column Attribute

1 METRICID
2 VALUE
3 SERVERNAME
4 OBJECTNAME
5 INSTALLATION
6 APPLICATION
Integrating HPOM Reporting and Graphing Products with the Oracle AS SPI 73



Viewing Graphs that Show Alarm Conditions

For graphing purposes, the Oracle AS SPI organizes metrics according to type. When a 
message is generated for any metric (listed in Table 4 on page 74), you can view a chart of its 
and other metric values. 

To view a graph associated with an alarm condition (Operator-initiated action has been 
defined with the Oracle AS SPI monitor template), follow these steps:

1 In the HPOM Message Browser double-click the message.

2 In the Message Details window, click Perform Action.

The resulting action displays the metric’s Oracle AS SPI graph, which charts its values along 
with the values of other metrics in the same group. 

Viewing Graphs that Show Past/Current Conditions

You can also generate any of the graphs manually by using the View Graphs application. 

To manually generate a graph, follow these steps:

1 At the HPOM console open both the Node Bank and the Application Bank windows.

2 In the Node Bank window, select the node for which you want the graph generated.

3 In the Application Bank window double-click OASSPI and in the next window 
double-click OASSPI Admin.

4 Drag and drop the node onto the View Graphs application.

Oracle AS SPI Metrics Available for Graphs

The tables that follow show the graphs available for mapping collected metric values. If you 
are interested in viewing any one of the metrics included in any of these tables, you can use 
the View Graphs application to launch the graph, which appears in your web browser.

Table 4 Metrics for Graphs

Title Description

Oracle 
AS 
Version Metric

JVM Memory Utilization JVM heap memory utilization 9.04, 
10.1.2, 
10.1.3

5

CPU and Memory Utilization Percentage of server CPU time 
utilization and server memory size 
utilization

9.04, 
10.1.2, 
10.1.3

11

CPU Utilization Percentage of server CPU time 
utilization

9.04, 
10.1.2

10

HTTP Server Active 
Connections

Number of active connections to the 
HTTP server

9.04, 
10.1.2, 
10.1.3

100
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HTTP Server Response Data HTTP server average response data size 
processed and HTTP server average 
response data size processed for the 
virtual host

9.04, 
10.1.2, 
10.1.3

108, 
109

HTTP Server CPU Utilization Percentage of the CPU time utilized by 
HTTP server over the collection interval

10.1.3 12

OC4J EJB Threads EJB method client and EJB method 
wrappers active threads count

9.04, 
10.1.2, 
10.1.3

20, 30

OC4J EJB Execution Time Average execution time of the EJB 
method client and EJB method wrappers

9.04, 
10.1.2, 
10.1.3

21, 31

OC4J EJB Calls Process Rate EJB method client calls and EJB method 
wrappers calls process rate for the 
interval

9.04, 
10.1.2, 
10.1.3

22, 32

Servlet Threads Total number of threads servicing all 
servlets

9.04, 
10.1.2

42

JSP Requests Number of active JSP requests 9.04, 
10.1.2, 
10.1.3

47

JMS Metrics Number of JMX connections (local and 
remote) created by the JMS server during 
the interval and number of messages in 
the destination store

9.04, 
10.1.2, 
10.1.3

50, 51

JDBC Connection Pool Percentage of JDBC connection pool 
utilization

9.04, 
10.1.2, 
10.1.3

260

OC4J Web Context Requests OC4J web context average request 
processing time and number of active 
sessions

9.04, 
10.1.2, 
10.1.3

280, 
281

Thread pool Utilization Percentage utilization of available 
connections in thread pool

10.1.3 14

Thread pool Wait Count Number of task(s) waiting in the queue 
for a thread to become available

10.1.3 15

Stateless Session Bean pool 
Utilization

Stateless Session Bean pool utilization 10.1.3 233

Stateful Session Bean pool 
Utilization

Stateful Session Bean pool utilization 10.1.3 234

Entity Bean pool Utilization Entity Bean pool utilization 10.1.3 235

Table 4 Metrics for Graphs

Title Description

Oracle 
AS 
Version Metric
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Launching the Web Page Display with an Operator Action that Generates 
Graphs

Performance Manager graphs can be generated from most Oracle AS SPI alarm messages by 
pressing Perform Action from the message details, Properties, or the Message Browser. The 
operator action launches your web browser, which displays a graph of the metric that 
generated the message, as well as other related metrics.

Specifying a Date Range

Within the web page display, you can specify a date range of one day, one week, one month, or 
one year. See the online Help for instructions on changing display settings.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by 
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all 
data for all instances are reported in one graph. The data for each SERVERNAME can also be 
displayed in a separate graph.

This example also uses the Java interface option of HP Performance Manager.

1 Start the Java Interface option of HP Performance Manager. The Performance Manager 
Java Interface window opens.

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window, and then the Sources tab at the right of 
the window.

b Click  next to the Datasource text box and select a data source 
(OASSPI_RPT_METRICS).
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c Click  next to the Default Selection text box and select the node on which the data 
source resides.

3 Click the General tab at the right of the window. 

4 From this window,

a Select line from the Type drop-down list. This generates a line graph.

b Enter a Date Range.

c Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection 
window opens. 

6 From the Metric Selection window,

a Next to the OASSPI_RPT_METRICS data source, click + to expand it in the tree.

b Select the VALUE check box.

c Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which 
VALUE is displayed and click Properties. The Metric Properties window opens. 

8 From the Metric Properties window,

a In the Label text box, enter: 

— @@SERVERNAME:@@OBJECTNAME if you are creating one graph with all 
SERVERNAMEs 

— @@OBJECTNAME if you are creating one graph with one SERVERNAME

b In the Marker drop-down list, select any marker other than none.

c In the Missing Data drop-down list, select:

— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click  next to the Filter text box. The Metric Filter window opens.

9 From the Metric Filter window,

a Select METRICID from the first drop-down list.

b Select = from the second drop-down list (if it is not already selected).

c Enter a metric number (for example, 11) in the text box.

d Click OK.

10 From the Metric Properties window,

a In the Filter text box, append the following:
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— &&SERVERNAME=@&&OBJECTNAME=@@ if you want one graph to display all 
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME=”<server_name>”&&OBJECTNAME=@ if you want one graph to 
display one SERVERNAME and all OBJECTNAMEs associated with the 
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file. 
For more information, see step step 13 on page 80.

b Click OK.

11 Click Save As at the top of the window. The Save As window opens.

12 From the Save As window,

a Enter a family (for example, OASSPI_Graphs) in the Family text box. The family 
name serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name text box to uniquely identify the 
graph.

c Entering text into the Category text box is optional. 

d Click OK. The information is saved in a graph template file named 
VPI_GraphsUser<family>.txt (for example, 
VPI_GraphsUserOASSPI_Graphs.txt).

For more information about this window, see the online help.

13 Edit the graph template file. The file is located in the HPOM data directory on the system 
of the HP Performance Manager instance on which you are working. The graph file might 
look similar to Figure 1.
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Figure 1

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: to the end of the first section of each graph (in the example above, 
add SUMFROMRAW: after SYSTEMNAME: moo1). This enables HP Performance Manager 
to summarized data from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter text box in the Metrics Properties window in step 
step 10 on page 79, edit the FILTER field.

c Save the file. The graph file now contains the following (see Figure 2):

#*********************************************

#* user Defined Graph Templates

#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] moo1

#**********************************************

FAMILY: OASSPI_Graphs

GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR:Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:
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Figure 2  

#*********************************************

#* user Defined Graph Templates
#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] moo1
#**********************************************
FAMILY: OASSPI_Graphs
GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

SUMFROMRAW:

END_GRAPH:
MISSINGDATA: previous
MARKER: rectangle
COLOR:Auto
LABEL: @@SERVERNAME:@@OBJECTNAME
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
METRIC: VALUE
CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS

SUMFROMRAW:
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14 From the Performance Manager Java Interface window, click the Display tab.

15 In this window, follow these steps:

a In the window below the Sources text box, navigate to the server on which the data 
source resides.

b In the Graphs window, navigate to the family of graphs and select the graph you 
created.

c Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph opens.

16 From the SPI, to enable graphing, follow these steps:

a From the HPOM console, open the Node Bank window and select a node or groups of 
nodes on which you want to enable graphing. 

b Open the Application Bank window.

c In the Application Bank window select OASSPI  OASSPI Admin. 

d Double-click UDM Graph Enable.

If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from 
the graph template file. You must edit the graph template file and re-enter this 
entry.
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6 Basic Troubleshooting and Error Messages
Self-Healing Info Application

The Self-Healing Info application gathers SPI troubleshooting data and stores it in a file that 
you can submit to HP support for assistance. For more information about this application, see 
Self-Healing Info on page 154.

The file created by the Self-Healing Info application might be hidden on some Windows 
managed nodes. If you do not see the file, open Windows Explorer and, from the Tools menu, 
select Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden 
files and folders.
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Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OvInstallDir%>/ is 
/var/opt/OV)

UNIX Managed Nodes

The following log and trace files are found on the managed nodes running on UNIX (typically, 
/<OvAgentDir>/ is /var/opt/OV/ or /var/lpp/OV/):

File Type Log

Filename /<%OvInstallDir%>/WASSPI/oas/log/ 
<managed_node>_disc_server.log

Description Records the updates done by the OASSPI Discovery policy to the 
management server’s configuration for each managed node. Log files are 
overwritten each time the discovery policy is run on the managed node. 
Logging to this file is always enabled.

File Type Log

Filename /<OvAgentDir>/log/javaagent.log

Description HPOM discovery agent log file containing the status of the HPOM 
discovery agent. By default, logging to this file is enabled at 
LOG_LEVEL 3. Set the LOG_LEVEL variable in <OvAgentDir>/conf/
svcDisc/OvJavaAgent.cfg to 6 or higher (up to 9) to capture 
troubleshooting information (the higher the number, the more 
information is collected). To disable this log, set the LOG_LEVEL to 0. 
Additional information can be configured in this file to define log file size 
and the number of archived files kept. By default, the log file size is 1MB 
and five archived versions are kept.

File Type Log

Directory /<OvAgentDir>/log/oasspi/config.log

Description Records output from the Oracle AS SPI configuration scripts. 

File Type Log

Directory /<OvAgentDir>/log/oasspi/errorlog

Description Records Oracle AS SPI error messages. This log file is monitored by 
Oracle AS SPI templates.
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File Type Trace

Filename /<OvAgentDir>/log/oasspi/wasspi_oas_discovery.trc
and /<OvAgentDir>/log/oasspi/
oasspi_oas_jmx_discovery.trc

(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. By 
default, tracing to this file is enabled. To disable tracing, in 
<OvAgentDir>/bin/instrumentation/
wasspi_oas_discovery.pl, set the $trace_on variable to 0. To enable 
this trace, set the $trace_on to 1. When instrumentation is deployed, the 
wasspi_oas_discovery.pl file is overwritten (therefore, if you 
disable tracing, it becomes enabled when instrumentation is deployed). 
Five archived versions are kept. A new trace file is created when the 
discovery policy is run.

File Type Trace

Directory /<OvAgentDir>/log/oasspi/trace.log (archived files have a three 
digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTANT or TRANSIENT mode in the SPIConfig 
file. The default value of the Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use the 
Start Tracing application.

File Type Trace

Directory /<OvAgentDir>/log/oasspi/traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
'PERSISTENT' mode in the SPIConfig file. The default value of the 
Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
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Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows 
(typically, <OvAgentDir> is 
\Program Files\HP OpenView\Installed Packages\{790 ...}\):  

File Type Log

Filename \<OvAgentDir>\log\javaagent.log

Description HPOM discovery agent log file containing the status of the HPOM 
discovery agent. By default, logging to this file is enabled at LOG_LEVEL 
3. Set the LOG_LEVEL variable in 
<OvInstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher 
(up to 9) to capture troubleshooting information (the higher the 
number, the more information is collected). To disable this log, set the 
LOG_LEVEL to 0. Additional information can be configured in this file 
to define log file size and the number of archived files kept. By default, 
the log file size is 1MB and five archived versions are kept.

File Type Log

Directory \<OvAgentDir> \wasspi\oas\log\config.log

Description Records output from configuration scripts.

File Type Log

Directory \<OvAgentDir> \wasspi\oas\log\errorlog

Description Records Oracle AS SPI error messages. This log file is monitored by 
Oracle AS SPI templates.

File Type Trace

Filename \<OvAgentDir>\wasspi\oas\log\wasspi_oas_discovery.trc
and \<OvAgentDir>\wasspi\oas\log\
wasspi_oas_jmx_discovery.trc 

(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. 
By default, tracing to this file is enabled. To disable tracing, in
\<%OvInstallDir%>\bin\instrumentation\
wasspi_oas_discovery.pl, set the $trace_on variable to 0. To 
enable this trace, set the $trace_on to 1. When instrumentation is 
deployed, the wasspi_oas_discovery.pl file is overwritten 
(therefore, if you disable tracing, it becomes enabled when 
instrumentation is deployed). Five archived versions are kept. A new 
trace file is created when the discovery policy is run.
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File Type Trace

Directory \<OvAgentDir> \wasspi\oas\log\trace.log (archived files have a 
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTENT or TRANSIENT mode in the 
SPIConfig file. The default value of the Collector Mode is 
PERSISTENT.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.

File Type Trace

Directory \<OvAgentDir>\wasspi\oas\log\traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
PERSISTENT mode in the SPIConfig file. The default value of the 
Collector Mode is PERSISTENT.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
Basic Troubleshooting and Error Messages 89



Troubleshooting the Discovery Process

Problem: The OASSPI-Discovery template does not automatically discover and update the 
Oracle AS SPI configuration.

Solutions:

1 Check for errors in the message browser of the managed nodes not being discovered. 
Follow the instruction text of any error messages displayed.

2 Verify that an Oracle OC4J/OHS server is installed on the managed node. If an OC4J/
OHS server is not installed, install an OC4J/OHS server, and complete the configuration 
tasks listed in Chapter 3, Configuring the Oracle AS SPI.

3 Verify the Oracle Application Server status. The application server must be running.

4 Verify the Java home directory (see Verifying the Java Home Directory on page 91).

5 Verify that the Configure OASSPI application is not running. Only one process can access 
the configuration at a time. If Configure OASSPI is running, other processes that must 
access the configuration (like the discovery process) hang until the configuration becomes 
available.

6 Check if the HPOM management server is suppressing duplicate messages: 

a From the HPOM console, select Actions Server Configure. The Configure 
Management Server window opens.

b Look for the “Suppress and count duplicate messages” check box. If this box is 
selected, unselect it.

7 Restart the HPOM management server:

a Stop all HPOM GUIs that are running by selecting File  Exit.

b Stop the HPOM management server processes. Enter: 
/opt/OV/bin/ovstop opc ovoacomm

c Delete all HPOM temporary files. All pending messages (messages not saved in the 
database) and all pending actions (automatic actions, operator-initiated actions, 
scheduled actions, and command broadcast) are lost. Enter: 
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*

d Restart the HPOM management server process. Enter: 
/opt/OV/bin/OpC/opcsv -start
/opt/OV/bin/OpC/opcsv -status

e Restart the HPOM GUI. Enter: opc

Problem: The OASSPI-Discovery template is adding inaccurate information to the 
configuration.

Solutions:

1 Verify the Java home directory. For more information, see Verifying the Java Home 
Directory on page 91.

2 Update the configuration and unselect the AUTO_DISCOVER check box in the 
configuration editor to prevent the OASSPI-Discovery template from overwriting the 
configuration information.

Problem: The following error messages display when the Discover Oracle AS application is 
run:
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/usr/lib/dld.sl: Can’t find path for shared library: libiconv.sl
/usr/lib/dld.sl: No such file or directory
sh: 25691 Abort (coredump)

Solution:

Install the libiconv.sl file on the HPOM management server. Download this file from:
http://hpux.connectisl.com/hppd/hpux/Development/Libraries/

Verifying the Java Home Directory

To successfully use the OASSPI-Discovery template, the Java home directory (on both a 
Windows and UNIX managed node) must be configured correctly.

Although the discover template searches for this information, if it cannot find this 
information or the information is not accurate, the discover template does not function 
completely.

On each managed node on which you want to run the discover template, verify one of the 
following (listed in the order of precedence used by the discover template):

• JAVA_HOME is correctly defined in the configuration. To edit or view the configuration, 
run the Configure OASSPI application:

a At the HPOM console, select the node(s) in the Node Bank window. 

b Select Application Bank.

c In the Application Bank window select OASSPI  OASSPI Admin  Configure OASSPI. 
(If the items do not appear, select Map  Reload.)

d The Introduction window opens. 

Click Next.

e From the configuration editor, set the JAVA_HOME property. For more information 
about using the configuration editor, see Using the Configuration Editor on page 131.

f Click Save to save the changes made to the configuration. Once you save your changes, 
you cannot automatically undo them.

g Click Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Click OK.

h Run the Discover Oracle AS application on the managed nodes on which the 
JAVA_HOME property was added or edited. Running the Discover Oracle AS 
application updates the service map.

• The JAVA_HOME system variable is correctly defined.

On a Windows manage node, follow these steps:

a Select Start  Settings  Control Panel.

b Double-click System.

c Click the Advanced tab.

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Discover Oracle AS application, click Next from the 
configuration editor, and then click OK.
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d Select Environment Variables ...

e Scroll through the System variables list. Verify the JAVA_HOME value. If 
JAVA_HOME does not exist, it is not defined.

On a UNIX manage node, follow these steps:

a Type echo $JAVA_HOME

b Verify the output. If no output is returned, JAVA_HOME is not defined.

Troubleshooting the Configuration

Problem: The OASSPI-Discovery template overwrites the configuration with inaccurate 
information.

Solution: Update the configuration and unselect the AUTO_DISCOVER check box in the 
configuration editor to prevent the OASSPI-Discovery template from overwriting the 
configuration information.
92                                                                                                                                                                                       Chapter 6 



Troubleshooting the Applications

• Problem: Configuration variable SERVER<n>_START_CMD missing for server ‘Default 
Server’

Solution: Before you can successfully run the Start Oracle AS application, you must set 
the START_CMD and USER properties. Set these properties using the Configure OASSPI 
application. For more information about this application, see Configure OASSPI on 
page 150.

• Problem: Configuration variable SERVER<n>_STOP_CMD missing for server "Default 
Server"

Solution: Before you can successfully run the Stop Oracle AS application, you must set 
the STOP_CMD and USER properties. Set these properties using the Configure OASSPI 
application. For more information about this application, see Configure OASSPI on 
page 150.

• Problem: When launched, the Verify application gives improper output.

Solution: Before you launch the Verify application ensure that you have installed the 
latest version of Self-Healing Service (SHS) component from the SPI DVD. 

• Problem: When launched, the Self-Healing Info application gives improper output.

Solution: Ensure that you have installed the latest version of Self-Healing Service (SHS) 
component from the SPI DVD. 

• Problem: When launching the applications, the applications hang or there is no output.

Solution: The applications will not work if the memory is low. Check the performance of 
the node and the management server. The physical memory available must be more than 
500 MB.

• Problem: View Status application shows a wrong status for a server instance or does not 
give any output.

Solution: If a server is up and running but View Status application returns the server 
status as NOT_RUNNING (or does not give any output), then turn ON the monitoring for 
that particular server by using the Start Monitoring application.

• Problem: Datasource not getting created on RHEL 4.0 platform.

Solution: Ensure that you have installed the latest version of DSI2DDF component from 
the SPI DVD. 
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Error Messages

This section provides detailed information on error messages resulting from conditions 
detected in the operation of the Oracle AS SPI, not the Oracle Application Server itself. The 
error messages discussed in this chapter, belong to the OASSPI Message Group.

For any given problem, only the most recent error message is displayed (the older error 
message is automatically acknowledged). This reduces the number of error messages 
displayed in the message browser.
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WASSPI-1

WASSPI-2

Description Unable to create the lock file <filename>. File already exists.

Severity Critical

Help Text Probable Cause
Temporary lock files are used to avoid collisions if multiple Oracle AS SPI data collector 
processes attempt to access the same data file. This error occurs when the lock file cannot be 
created after several attempts because the file already exists.
Suggested Action
If a file by the same name already exists, it might not have been deleted by a previous run of 
the Oracle AS SPI data collector. You should delete this file manually.

Description Cannot access the SPI configuration.

Severity Critical

Help Text Probable Cause
A Oracle AS SPI configuration file could not be located or accessed. Either the file does not 
exist or there was a problem reading the file.
Suggested Action
1 Verify that the collector template that runs the Oracle AS SPI data collector specifies the 

correct directory on the command line. The option 
-Dwasspi.config.dir=<configDirectory> must be specified on command line invocation 
of the data collector. See Managed Node File Locations on page 127 for configuration 
directory <configDirectory>.

2 Verify that the Oracle AS SPI configuration files, SiteConfig and SPIConfig, are 
located in the directory specified on the command line in step 1. If not, run the Oracle AS 
SPI configuration, accessed from the Application Bank  OASSPI  OASSPI Admin 
windows, to reinstall the files.

3 See the text following the error message in the Oracle AS SPI error log to help identify 
the underlying cause of the problem (for example, an I/O exception).You can view the 
Oracle AS SPI error log for a managed node by using the View Error Log application 
accessed from the Application Bank  OASSPI  OASSPI Admin windows. The error 
message can be identified by the date/time stamp.
Basic Troubleshooting and Error Messages 95



WASSPI-3

WASSPI-4

Description Error parsing command line.

Severity Critical

Help Text Probable Cause
The Oracle AS SPI data collector command line is incorrectly specified in a collector 
template.
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the data collector command line syntax error. You can view the Oracle AS SPI error log 
for a managed node by using the View Error Log application accessed from the 
Application Bank  OASSPI  OASSPI Admin windows. The error message can be identified 
by the date/time stamp.

2 If the error occurred in a collector template that shipped with the Oracle AS SPI, reinstall 
the Oracle AS SPI.

3 If the error occurred in a collector template not shipped with the Oracle AS SPI, correct 
the collector template that contains the incorrect command line. For more information on 
the Oracle AS SPI data collector command line, see Using the Oracle AS SPI Collector/
Analyzer Command with Parameters on page 57.

Description Error getting the metric definitions.

Severity Critical

Help Text Probable Cause
The Oracle AS SPI data collector could not read the metric definitions XML document. This 
error can be caused by a missing configuration property, an I/O error, an XML parsing error, 
a missing file, or a corrupted serialized data file.
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the underlying cause of the problem. You can view the Oracle AS SPI error log for a 
managed node by using the View Error Log application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows. The error message can be identified by the date/time 
stamp.

2 If the problem is with the metric definitions file (MetricDefinitions.xml) that is 
shipped with the Oracle AS SPI, reinstall the Oracle AS SPI. Run the Configure OASSPI 
application accessed from the Application Bank  OASSPI  OASSPI Admin windows.

3 If the problem is with a user-defined metric definitions file that is not shipped with the 
Oracle AS SPI, verify that this XML file adheres to the MetricDefinitions.dtd 
specification. For more information on writing user-defined metrics, see the HP 
Operations Smart Plug-in User Defined Metrics User Guide. Reinstall your user-defined 
metric definition file. 

4 If the underlying error is ClassNotFound, this is an internal error. Report this to your HP 
support representative.
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WASSPI-5

WASSPI-6

Description Error processing metric <metric_number>.

Severity Major

Help Text Probable Cause
An error occurred while trying to collect data or perform calculations for the specified metric. 
Suggested Action
See the text following the error message in the Oracle AS SPI error log to help identify the 
underlying cause of the problem. The error messages previous to this one provide more 
information about the problem. You can view the Oracle AS SPI error log for a managed 
node by using the View Error Log application accessed from the Application Bank  OASSPI  
OASSPI Admin windows. The error message can be identified by the date/time stamp.

Description Required property <property_name> is missing from the Oracle AS SPI configuration.

Severity Major

Help Text Probable Cause
A required property is missing from the Oracle AS SPI configuration. 
Suggested Action
1 Run the Configure OASSPI application accessed from the Application Bank  OASSPI  

OASSPI Admin windows. Verify that you specified the correct server information for the 
Oracle OC4J/OHS servers on this managed node.

2 Verify that the property is specified correctly in the Oracle AS SPI configuration file (/
var/opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed node 
in question.
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WASSPI-7

WASSPI-8

Description Unable to contact server <server_name> at url=<URL>, port=<port>.

Severity Major

Help Text Probable Cause
The specified server is not running at the specified port.
Suggested Action
1 Run the Configure OASSPI application, accessed from the Application Bank  OASSPI  

OASSPI Admin windows. Verify that you specified the correct server name and port 
information for the Oracle OC4J/OHS servers on this managed node.

2 Verify that the properties, SERVER<n>_NAME and SERVER<n>_PORT, are specified correctly 
in the Oracle AS SPI configuration file (
/var/opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed 
node in question.

3 Verify that the Oracle OC4J/OHS server is running on the managed node.

Description Error saving graphing or reporting data to file <file_name>.

Severity Critical

Help Text Probable Cause
The specified graphing or reporting data file could not be found or an I/O error occurred 
when trying to access the file.
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the underlying cause of the problem. You can view the Oracle AS SPI error log for a 
managed node by using the View Error Log application accessed from the Application 
Bank  OASSPI  OASSPI Admin windows. The error message can be identified by the 
date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank  OASSPI  OASSPI Admin windows) and reproduce the problem. For more 
information about available applications, see Applications on page 18. 
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-9

WASSPI-10

Description Unable to retrieve property <property_name>.

Severity Critical

Help Text Probable Cause
A required property is missing from one of the Oracle AS SPI configuration files. 
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the missing property. You can view the SPI error log for a managed node by using the 
View Error Log application accessed from the Application Bank  OASSPI  OASSPI 
Admin windows. The error message can be identified by the date/time stamp.

2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 
Oracle AS SPI configuration application. Verify that you specified the correct information 
for the Oracle OC4J/OHS servers on the managed node in question.

3 Verify that the missing property is specified in the Oracle AS SPI configuration file (/
var/opt/OV/wasspi/oas/conf/SiteConfig or
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed 
node in question.

Description Encountered problem accessing file <filename>.

Severity Critical

Help Text Probable Cause
The specified file could not be found, created, or accessed. This file could be a temporary file. 
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the file in question and the underlying cause of the problem. You can view the Oracle AS 
SPI error log for a managed node by using the View Error Log application accessed from 
the Application Bank  OASSPI Admin  OASSPI Admin windows. The error message can 
be identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.
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WASSPI-11

WASSPI-12

Description No servers have been specified in the Oracle AS SPI configuration file. 

Severity Major

Help Text Probable Cause
The number of Oracle OC4J/OHS servers specified in the Oracle AS SPI configuration for 
the managed node in question is 0.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. Verify that you have specified the correct server 
name and port information for the Oracle OC4J/OHS servers on this managed node.

2 Verify that the property NUM_SERVERS in the Oracle AS SPI configuration file (
/var/opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) is set to the number 
of Oracle OC4J/OHS servers on this managed node.

Description Opcmon returned an error code of <error_number> for the command <opcmon_command>. 

Severity Critical

Help Text Probable Cause
The opcmon process started by the Oracle AS SPI collector has returned an error (non-zero) 
exit code.
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

3 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-13

WASSPI-14

Description Exception occurred while running an opcmon process. 

Severity Critical

Help Text Probable Cause
The Oracle AS SPI data collector attempted to run a process to start an opcmon call. Either 
the process could not be created or was interrupted.
Suggested Action
For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are 
set high enough to enable process creation.

Description Unable to find file <filename>. 

Severity Critical

Help Text Probable Cause
A file required by the Oracle AS SPI data collector could not be found. 
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the file in question and the underlying cause of the problem.You can view the Oracle AS 
SPI error log for a managed node by using the View Error Log application accessed from 
the Application Bank  OASSPI  OASSPI Admin windows. The error message can be 
identified by the date/time stamp.

2 Reinstall the Oracle AS SPI.
3 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
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WASSPI-15

WASSPI-16

Description Error parsing XML document <filename>. 

Severity Critical

Help Text Probable Cause
An error occurred while parsing the specified XML document. 
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the underlying cause of the problem. You can view the Oracle AS SPI error log for a 
managed node by using the View Error Log application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows. The error message can be identified by the date/time 
stamp.

2 If the XML document was provided by the user, correct the document. For more 
information about the correct format for a user-defined metric definition document, see 
the HP Operations Smart Plug-in User Defined Metrics User Guide.

3 If the XML document is a document that is shipped with the Oracle AS SPI, from the 
Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the Oracle 
AS SPI configuration application to reinstall the Oracle AS SPI configuration files.

Description A bad filter was specified for metric <metric_number>. 

Severity Major

Help Text Probable Cause
A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action
1 If the metric is specified in an XML document that was provided by the user, correct the 

document. For more information about the correct format for a user-defined metric 
definition document, see the HP Operations Smart Plug-in User Defined Metrics User 
Guide.

2 If the metric is a pre-defined metric that is shipped with the Oracle AS SPI, from the 
Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the Oracle 
AS SPI configuration application in order to reinstall the Oracle AS SPI configuration 
files.
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WASSPI-18

WASSPI-19

WASSPI-20

Description Error logging to datasource <datasource_class_name>. Logging process returned exit code 
<exit_code>.

Severity Critical

Help Text Probable Cause
The ddflog process started by the Oracle AS SPI data collector returned a non-zero error 
code. 
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank  OASSPI  OASSPI Admin windows) and reproduce the problem. For more 
information about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

3 Contact your HP support representative with the information gathered in the previous 
steps.

Description Encountered problem instantiating XSLT transformer with <filename>. 

Severity Major

Help Text Probable Cause
The XSL document that specifies the auto action report output contains errors.
Suggested Action
1 Reinstall the Oracle AS SPI.
2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 

Description Encountered problem creating report for metric <metric_number>. 

Severity Major

Help Text Probable Cause
An error occurred while producing a text report for the specified metric.
Suggested Action
1 Reinstall the Oracle AS SPI.
2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
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WASSPI-21

WASSPI-23

Description Encountered problem instantiating factory implementation.
'<class name>'.

Severity Critical

Help Text Probable Cause: The java property specifying the class name is incorrect or the class does 
not implement the AppServerFactory interface.
Suggested Action: Verify that the java property appserver.implementation is set to the 
fully qualified name of the class which implements the AppServerFactory interface. 

Description Error initializing collector analyzer for server <server_name>.

Severity Critical

Help Text Probable Cause 
An exception was encountered while preparing to monitor the specified server.
Suggested Action 
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the problem. You can view the SPI error log for a managed node by using the View Error 
Log application accessed from the Application Bank  OASSPI  OASSPI Admin windows. 
The error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank  OASSPI  OASSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-24

WASSPI-26

Description Error logging in to server <server_name> with login <login>.

Severity Critical

Help Text Probable Cause 
A security exception occurred while logging in to the specified server.
Suggested Action 
1 Run the Configure OASSPI application (by using the Configure OASSPI application 

accessed from the Application Bank  OASSPI  OASSPI Admin windows).
2 Verify that you have specfied the correct login and password on the managed node on 

which the error occurred.
3 Verify the login has appropriate permissions.

Description The data logging process for <server_name> timed out.

Severity Major

Help Text Probable Cause 
Depending on your configuration, either HP Performance Agent or CODA failed to exit 
before the time-out.
Suggested Action 
1 Restart HP Performance Agent using the command mwa restart.
2 Restart CODA using the command opcagt -start.
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WASSPI-27

WASSPI-30

WASSPI-31

Description RMI collector unable to process <command>.

Severity Warning

Help Text Probable Cause 
An exception was encountered while performing an rmid related operation.
Suggested Action 
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the problem. You can view the SPI error log for a managed node by using the View Error 
Log application accessed from the Application Bank  OASSPI  OASSPI Admin windows. 
The error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank  OASSPI  OASSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous 
steps.

Description Failed to start <rmid_path> on port <port>.

Severity Critical

Help Text Probable Cause 
The specified port is already in use.
Suggested Action 
1 Run the Configure OASSPI application (by using the Configure OASSPI application 

accessed from the Application Bank  OASSPI  OASSPI Admin windows) and set the 
RMID_PORT property to a port number which is not currently in use.

Description Lost connection to RMI collector while processing <command>.

Severity Warning

Help Text N/A
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WASSPI-32

WASSPI-33

WASSPI-34

WASSPI-35

Description Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning

Help Text N/A

Description No actions matched server <server_name>, version <version>.

Severity Warning

Help Text Probable Cause 
JMXAction element(s) define FromVersion and ToVersion tags which do not match the 
server version.
Suggested Action 
If the action is valid on the server, then either modify the JMXAction definition’s 
FromVersion/ToVersion elements or modify the server’s VERSION property.

Description Metric <metric_id> does not define any actions.

Severity Warning

Help Text Probable Cause 
The metric ID specified with the -m option does not define a JMXActions element.
Suggested Action 
Correct the -m option if an incorrect metric ID was specified. Otherwise, add a JMXActions 
definition to the metric definition.

Description Error executing action <action_command-line>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while executing the action.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).
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WASSPI-36

WASSPI-37

WASSPI-38

Description MBean <JMX_objectname> on server <server_name> does not expose operation 
<operation_name>.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action 
Correct the JMXCalls element or remove the operation from the element.

Description MBean <JMX_objectname> on server <server_name> does not expose attribute 
<attribute_name> for write.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines a write attribute exposed by the specified MBean as 
read-only.
Suggested Action 
If the specified MBean is a custom MBean, update its management interface so that the 
attribute is writable. Otherwise, remove the attribute definition from the JMXCalls element.

Description MBean <JMX_objectname> on server <server_name> does not expose attribute 
<attribute_name>.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines an attribute not exposed by the specified MBean 
ObjectName.
Suggested Action 
Correct the JMXCalls element or remove the attribute from the element.
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WASSPI-39

WASSPI-40

WASSPI-41

Description Error invoking operation <operation_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while invoking an operation on the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description Error setting attribute <attribute_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while setting an attribute on the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description Error getting attribute <attribute_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while getting an attribute from the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).
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WASSPI-42

WASSPI-43

WASSPI-201

Description Error running command <command>.

Severity Critical

Help Text Probable Cause 
A command started by the Oracle AS SPI collector reported an error..
Suggested Action 
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

3 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank  OASSPI  OASSPI Admin windows).

4 Contact your HP support representative with the information gathered in the previous 
steps.

Description Error publishing event <event-type>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description File <filename> not found.

Severity Critical

Help Text Probable Cause 
A configuration file could not be found.
Suggested Action 
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that the correct information has been specified for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
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WASSPI-202

WASSPI-203

WASSPI-204

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause

1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action

1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 
Oracle AS SPI configuration application. 

2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 
on the managed node on which the error occurred.

3 Verify that the permissions are correct for the HPOM user to read this file.

Description Cannot write file <filename>.

Severity Critical

Help Text Probable Cause
Permissions might be incorrect, or a file or directory might be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that you specified the correct information for the Oracle OC4J/OHS servers on the 

managed node on which the error occurred.
3 Verify that the permissions are correct for the HPOM user to write this file.

Description Error sending opcmsg <message>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmsg. “opcmsg” might be missing or not have permissions to 
run (HPOM installation errors) or the system process table might be full.
Suggested Action
1 Confirm that HPOM is properly installed and deployed to the managed node.
2 Ensure that the process table is not full. If it is, consider having the system administrator 

increase it.
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WASSPI-205

WASSPI-206

WASSPI-207

Description Error sending opcmon <command>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmon. “opcmon” might be missing or not have permissions to 
run (HPOM installation errors) or the system process table might be full.
Suggested Action
1 Confirm that HPOM is properly installed and deployed to the managed node.
2 Ensure that the process table is not full. If it is, consider having the system administrator 

increase it.

Description Cannot read directory <directory>.

Severity Critical

Help Text Probable Cause
The permissions on the directory prevent the HPOM user from reading it or the directory is 
corrupt.
Suggested Action
Verify that the permissions are correct for the HPOM user for this directory.

Description Cannot move <filename> to <filename>.

Severity Critical

Help Text Probable Cause
1 Insufficient permissions.
2 Insufficient disk space.
3 File table problems.
Suggested Action
1 Verify that the permissions are correct for the HPOM user.
2 Verify that there is enough disk space to create files.
3 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
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WASSPI-208

WASSPI-209

Description OASSPI must be configured before it can be used.

Severity Critical

Help Text Probable Cause
The Oracle AS SPI has not been configured on this node.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
3 From the Application Bank, select OASSPI  OASSPI Admin  OASSPI Verify to run the 

verification application to confirm that the Oracle AS SPI has been successfully 
configured.

Description Cannot contact Oracle Application Server.

Severity Critical

Help Text Probable Cause
1 The server could be down or not responding.
2 The Oracle AS SPI might be configured incorrectly.
Suggested Action
1 Verify that the Oracle OC4J/OHS server is up and running properly.
2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
3 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
4 From the Application Bank, select OASSPI  OASSPI Admin  OASSPI Verify to run the 

verification application to confirm that the Oracle AS SPI has been successfully 
configured.
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WASSPI-210

WASSPI-211

WASSPI-213

Description Cannot configure OASSPI.

Severity Critical

Help Text Probable Cause
The Oracle AS SPI configuration process failed.
Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify the 

underlying cause of the problem. The error messages previous to this one provide more 
information about the problem. You can view the Oracle AS SPI error log for a managed 
node by using the View Error Log application accessed from the Application Bank  
OASSPI  OASSPI Admin windows. The error message can be identified by the date/time 
stamp.

2 Reinstall the Oracle AS SPI.
3 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 

Description Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause
There are insufficient permissions for the HPOM user to create the directory or there is 
insufficient disk space.
Suggested Action
Verify that the permissions are correct for the HPOM user for this directory and verify that 
there is enough disk space.

Description  Improper parameters to program <name>. Usage: <usage>.

Severity Critical

Help Text Probable Cause
The parameters to the program are incorrect.
Suggested Action
Correct the parameters.
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WASSPI-214

WASSPI-216

WASSPI-218

Description Cannot run program <program_name>.

Severity Critical

Help Text Probable Cause
The program failed to run. It might be missing, permissions might be incorrect, or the 
process table might be full.
Suggested Action
1 Verify that the file exists. If it is a Oracle AS SPI program and the file is missing, reinstall 

the Oracle AS SPI and, from the Application Bank, select OASSPI  OASSPI Admin  
Configure OASSPI to run the Oracle AS SPI configuration application.

2 Verify that the permissions are correct for the HPOM user. 

Description Configuration variable <name> missing for server <server_name>.

Severity Critical

Help Text Probable Cause
A required Oracle AS SPI configuration property was not found.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that the correct information has been specified in the configuration for the 

managed node on which the error occurred. 

Description  Oracle Application Server monitoring has been turned OFF for <server_name>.

Severity Warning

Help Text Probable Cause
Collection has been turned off for the specified server.
Suggested Action
If desired, collection can be turned on by setting COLLECT = ON in the SiteConfig file in the 
Oracle AS SPI configuration directory on the managed node. The configuration directory is /
var/opt/OV/wasspi/oas/conf/ or 
/var/opt/OV/conf/oas/ on UNIX platforms or 
/usr/OV/wasspi/oas/conf/ on Windows platforms. 
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WASSPI-219

WASSPI-221

Description Oracle Application Server monitoring has been turned ON for <server_name>.

Severity Critical

Help Text Probable Cause
Collection has been turned on for the specified server.
Suggested Action
If desired, collection can be turned off by setting COLLECT = OFF in the SiteConfig file in 
the Oracle AS SPI configuration directory on the managed node. The configuration directory 
is /var/opt/OV/wasspi/oas/conf/ or 
/var/opt/OV/conf/oas/ on UNIX platforms or /usr/OV/wasspi/oas/conf/ on 
Windows platforms.

Description <filename> does not exist.

Severity Critical

Help Text Probable Cause
The specified file does not exist. If it is a log file, no entries have ever been logged to it. If it is 
a property file, then it has not been configured.
Suggested Actions
• Log files - If there have never been any entries written to the file, no action is necessary. 

Otherwise, from the Application Bank, select OASSPI  OASSPI Admin  Configure 
OASSPI to run the Oracle AS SPI configuration application.

• Property files - From the application bank, select OASSPI  OASSPI Admin  Configure 
OASSPI to run the Oracle AS SPI configuration application.
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WASSPI-222

WASSPI-223

Description <filename> is empty.

Severity Critical

Help Text Probable Cause
The specified file is empty. If it is a log file, no entries have ever been logged to it, or the 
entries have been cleaned out. If it is a property file, then it is not properly configured.
Suggested Action
• Log files - If there have never been any entries written to the file, no action is necessary. 

Otherwise, from the Application Bank, select 
OASSPI  OASSPI Admin  Configure OASSPI to run the Oracle AS SPI configuration 
application.

• Property files - From the application bank, select OASSPI  OASSPI Admin  Configure 
OASSPI to run the Oracle AS SPI configuration application.

• Configuration - From the application bank, select OASSPI  OASSPI Admin  Configure 
OASSPI to run the Oracle AS SPI configuration application.

Description Cannot read <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. Verify that you have specified the correct 
information for the Oracle OC4J/OHS servers on the managed node on which the error 
occurred.

2 Verify that the permissions are correct for the HPOM user to read this file.
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WASSPI-224

WASSPI-225

Description ddfcomp returned an error configuring <name>.

Severity Critical

Help Text Probable Cause
ddfcomp returned an error. Neither MeasureWare nor CODA is installed on the system or 
MeasureWare or CODA is not configured correctly.
Suggested Action
1 If MeasureWare and CODA are not installed, this error can be ignored.
2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank  OASSPI  OASSPI Admin windows) and reproduce the problem. For more 
information about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps. 

Description No logfiles were found. Did you run OASSPI Config?

Severity Critical

Help Text Probable Cause
The logfile list is empty.
Suggested Action
1 Reinstall the Oracle AS SPI.
2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
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WASSPI-226

WASSPI-227

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
3 Verify that the permissions are correct for the HPOM user to read this file.

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
No HPOM agent is installed on the system.
Suggested Action
If you should have a performance agent installed, reinstall the performance agent. 
Otherwise, this message can be ignored.
Basic Troubleshooting and Error Messages 119



WASSPI-228

WASSPI-229

WASSPI-230

Description ddflog returned an error logging <logfile-name>: <system-error-msg>

Severity Warning

Help Text Probable Cause
An error was returned by ddflog. This error could have been caused by the Oracle AS SPI not 
being properly configured to support logging performance data.
Suggested Action
1 Try reconfiguring Oracle AS SPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.

Description Cannot connect to directory <directory_name>

Severity Warning

Help Text Probable Cause
The directory does not exist or the user the agent is running under does not have appropriate 
permissions to the directory.
Suggested Action
If you should have a performance agent installed, reinstall the performance agent. 
Otherwise, this message can be ignored.

Description Cannot get lock <filename> after <time-interval>

Severity Critical

Help Text Probable Cause
A Oracle AS SPI process is hung or taking longer than expected.
Suggested Action
1 Stop the HPOM agent on the managed node. Make sure all HPOM and Oracle 

Application Server processes have stopped. 
2 Check if the lock file is still there. If it is, remove it. 
3 Restart the agent.
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WASSPI-231

WASSPI-232

WASSPI-234

Description Cannot start the Java runtime engine.

Severity Critical

Help Text Probable Cause
1 The JAVA_HOME property in the SiteConfig file is not set correctly. 
2 Java is not properly installed on your system.
Suggested Action
1 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
2 Verify that you have specified the correct JAVA_HOME information on the managed node 

on which the error occurred.

Description Server <name> specified on command line, but not in configuration.

Severity Critical

Help Text Probable Cause
1 A -i or -e option was specified on the wasspi_oas_ca command line, but the server 

name specified is not configured in the SiteConfig file.
2 Java is not properly installed on your system.
Suggested Action
1 Specify a correct server name on the command line. 
2 From the Application Bank, select OASSPI  OASSPI Admin  Configure OASSPI to run the 

Oracle AS SPI configuration application. 
3 Verify that you have specified the correct server names in the configuration.

Description Error running program <file>, return value: <n>.

Severity Critical

Help Text Probable Cause
The SPI attempted to run the specified application or auxiliary program and encountered an 
error (the return code is specified).
Suggested Action
• If the application is a SPI application, make sure the SPI is installed and configured 

correctly. If not, reinstall or reconfigure the SPI.
• If the application is a system application, make sure there are no system problems that 

prevent the application from running. 
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WASSPI-235

WASSPI-236

WASSPI-237

WASSPI-238

Description Restart of MeasurWare agent failed.

Severity Warning

Help Text Probable Cause
The SPI attempted to automatically restart the MeasureWare agent and the automatic 
attempt failed.
Suggested Action
Restart the MeasureWare agent manually using the command mwa restart server.

Description Failure when running XSLT on <xml> with stylesheet <xsl>:<message>.

Severity Critical

Help Text Probable Cause
The translation of the UDM XML failed (part of setting up graphing for user defined 
metrics).
Suggested Action
Review the specified message and verify the XML.

Description This is an informational message that an OV_PM or MeasureWare datasource was set up.

Severity Normal

Help Text N/A

Description No user defined metrics found.

Severity Warning

Help Text Probable Cause
The UDM Graph Enable application was run, but no UDMs are defined.
Suggested Action
Verify that the UDM XML file is named correctly.
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WASSPI-241

WASSPI-254

WASSPI-261

WASSPI-262

WASSPI-263

Description Cannot delete file <file>.

Severity Critical

Help Text Probable Cause
The SPI failed to delete the specified file.
Suggested Action
Verify the file’s permissions. Enable the user/system to delete the file.

Description Java exited with an error.

Severity Critical

Help Text Probable Cause
While running the collector or other java application, either Java encountered an error or the 
Java application exited with an error.
Suggested Action
Check for other errors generated at the same time and the SPI’s error log for clues about the 
cause of the problem.

Description XML Parse Error

Help Text Probable Cause
The wasspi_oas_XMLParser file might be missing or the XML might be malformed.

Description Discovery Error

Help Text Probable Cause
Discovery failed. Review the errorlog and wasspi_oas_discovery.trc files on the 
managed node.

Description Windows Registry Error

Help Text Probable Cause
The Oracle Application Server installation might have failed or is not installed.
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WASSPI-261

WASSPI-601

WASSPI-602

WASSPI-603

Description XML Parse Error

Help Text Probable Cause
The wasspi_oas_XMLParser might be missing or the XML might be malformed.

Description Retrieving Oracle AS SPI configuration in HPOM server

Severity Normal

Help Text Probable Cause
The managed node has requested a copy of the master SiteConfig file.

Description Updating Oracle AS SPI configuration in HPOM server

Severity Normal

Help Text Probable Cause
This is a normal operation performed by the discovery application. 
If the operation is successful, the entry in the “A” (action) column for this message changes 
from “R” (running) to “S” (success).
Suggested Action
If the operation is not successful, the entry in the “A” (action) column for this message 
changes from “R” (running) to “F” (fail). Select this node and run the Discover Oracle AS 
application. 
If the problem persists, configure the Oracle AS SPI manually. For more information, see 
Chapter 3, Configuring the Oracle AS SPI.

Description Updated Oracle AS spi configuration in HPOM server

Severity Normal

Help Text Probable Cause
The discovery application has discovered some Oracle AS instances on the manged node. It 
has updated the Oracle AS SPI configuration on the HPOM management server.
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WASSPI-604

WASSPI-605

Description Oracle AS Discovery Failed

Severity Critical

Help Text Probable Cause
• Oracle AS was not installed on the managed node.
• There are no Oracle AS instances running on the managed node.
• Discovery needs more information to find all Oracle AS instances running on the 

managed node.
• The Oracle AS SPI does not have the correct configuration information for the Oracle AS 

instances.
Suggested Action
• Install Oracle AS or verify that Oracle AS is installed on the managed node.
• Make sure that all Oracle AS instances you want to monitor are up and running before 

running the Discover Oracle AS application. Discovery only finds Oracle AS instances 
that are running. Verify the servers are running from the Oracle AS Control Console.

• Run the Configure OASSPI application (select the managed node before starting the 
application) and set the HOME_LIST property. Then, run the Discover Oracle AS 
application.

• Verify the information set for the following properties: LOGIN, PASSWORD, NAME, and 
HOME_LIST. If you modify information for any of these properties, run the Discover 
Oracle AS application.

If the problem persists, configure the Oracle AS SPI manually. For more information, see 
Chapter 3, Configuring the Oracle AS SPI.

If manual configuration fails, run the SHS application accessed from the Application Bank  
OASSPI  OASSPI Admin windows. Contact your HP support representative with the 
gathered information. 

Description Could not find OAS home directory: <directory>

Severity Critical

Help Text Probable Cause
The specified directory was set in the HOME_LIST property but the directory does not exist.
Suggested Action
1 Verify that the directory exists on the managed node. 
2 Use the Configure OASSPI application to verify that the HOME_LIST property contains 

the specified directory and modify the value.
3 Run the Discover Oracle AS application.
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WASSPI-606

All Other Errors

Description Oracle AS version not found

Severity Critical

Help Text Probable Cause
The OraclesAS version string was not found. Oracle AS might not be installed on the 
managed node.
Suggested Action
Install Oracle AS or verify that Oracle AS is installed on the managed node.

Description An unknown error appears in the Oracle AS SPI error log.

Severity Major

Help Text Suggested Action
1 See the text following the error message in the Oracle AS SPI error log to help identify 

the problem. You can view the SPI error log for a managed node by using the View Error 
Log application accessed from the Application Bank  OASSPI  OASSPI Admin windows. 
The error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 

 OASSPI  OASSPI Admin windows) and reproduce the problem. For more information 
about available applications, see Applications on page 18.
Tracing information is saved to /<OvAgentDir>/log/oasspi/trace.log (archived 
files have a three digit number appended to the filename) where /<OvAgentDir>/ is 
typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.
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A File Locations
You can find Oracle AS SPI configuration files and error logs in specific directories.

HPOM Management Server File Locations  

Managed Node File Locations

On Windows or UNIX managed nodes that were already running the Oracle AS SPI and are 
being switched to a non-root HTTPS agent environment (UNIX only: if these directories do 
not exist, see the next table for file locations): 

Operating System File File Location

HP-UX Configuration /opt/OV/wasspi/oas/conf

Solaris Configuration /opt/OV/wasspi/oas/conf

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/conf/oasspi

HP-UX, Solaris, Linux Error Logs /var/opt/OV/log/oasspi

AIX Configuration /usr/lpp/OV/conf/oasspi

AIX Error Logs /usr/lpp/OV/log/oasspi

Windows (HTTPS) Configuration \Documents and Settings\All 
Users\Application Data\HP\HP BTO 
Software\wasspi\oas\conf

Windows (HTTPS)  Error Logs \Documents and Settings\All 
Users\Application Data\HP\HP BTO 
Software\wasspi\oas\log
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On newly configured Oracle AS SPI managed nodes in the non-root HTTPS agent 
environment (UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/conf/oasspi

HP-UX, Solaris, Linux Error Logs /var/opt/OV/log/oasspi

AIX Configuration /var/opt/OV/conf/oasspi

AIX Error Logs /var/opt/OV/log/oasspi
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B The Configuration 
This appendix explains how to use the configuration editor, describes of the configuration 
properties, and provides samples of the configuration.

Structure

See Sample Configurations for the Oracle AS SPI on page 146 for examples of the 
configuration. The basic structure of the configuration is (lines preceded by # are treated as 
comments and are ignored):

# Global Properties
property=<value> ...

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

# NODE Block
NODE <node_name | group_name>
{
property=<value> ...
}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can 
be overridden by properties set within a GROUP or NODE block or by server-specific 
properties.

GROUP Block

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block 
<group_name> is repeated within the configuration, the last definition takes precedence.

<node_name> lists the nodes in the group and is the primary node name configured in HPOM.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the 
Default Properties item in the <Group_Name> folder.

NODE Block

# NODE Block
NODE <node_name | group_name>
{
<property>=<value> ...
}

Properties set in a NODE block apply to nodes belonging to the group defined by 
<group_name> (to set common properties for a group) or to the specified <node_name> (to set 
properties for a single node).

For a group, enter the <group_name> defined by the GROUP block and define the group’s 
common properties.

For a single node, enter the <node_name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes 
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the 
Default Properties item in the <Node_Name> folder.

Server-Specific Properties

Each property specified as SERVER<n>_property refers to a specific Oracle OC4J/OHS server 
instance. When more than one Oracle OC4J/OHS server instance is running on a given 
managed node, the number <n> differentiates the servers. Numbering begins at “1” and each 
Oracle OC4J/OHS server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:

1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 <property> (global property)

The node name specified in a GROUP block matches the value returned by the HPOM 
variable $OPC_NODES, which is the primary node name configured in HPOM.
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Using the Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the 
configuration using this editor only.

The main features of the configuration editor are:

• Tree

• Buttons

• Actions

Configure OASSPI – Tree

The Configure OASSPI tree, displayed in the left pane of the Configure OASSPI application’s 
main window, displays the Oracle AS SPI configuration in a tree structure.

The following is an example of the tree.

.

The icons are defined as follows:

If no OC4J/OHS servers or groups are configured, the “OC4J/OHS Servers” and “Groups” 
folders are not displayed. If you are running Configure OASSPI for the first time and you did 
not select any nodes before you launched the application, the “Nodes” folder is not displayed

The configuration properties can be viewed.

The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name Description

OC4J/OHS Servers A folder that contains a list of all the OC4J/OHS servers. This 
folder can appear under Defaults (global properties), 
Group_Name(s) (GROUP block), or Node_Name(s) (NODE 
block).

<OC4J/OHS_Server_Name> The name of the OC4J/OHS server.

Configuration A folder that contains all Oracle AS SPI configuration 
information for the Oracle Application Server environment.

Default Properties Lists the configuration properties that are set. This item 
appears under Defaults (global properties), Group_Name(s) 
(GROUP block), or Node_Name(s) (NODE block).

Defaults A folder that represents the global properties. Default 
properties set at this level apply to all nodes. However, these 
properties can be overridden by properties set under the 
Group_Name and Node_Name folders (for more information, 
see Property Precedence on page 130 ).

Groups A folder that represents the GROUP block.

<Group_Name> A folder that identifies the name of a group of nodes with 
common properties. Default properties set at this level apply to 
all nodes that belong to the specified group. These properties 
can be overridden by properties set under the Node_Name 
folders (for more information, see Property Precedence on 
page 130).

Nodes A folder that represents the NODE block.

<Node_Name> A folder that represents a single node whose name matches the 
value returned by the HPOM variable $OPC_NODES, which is 
the primary node name configured in HPOM. Default 
properties set at this level apply to the specified node only (for 
more information, see Property Precedence on page 130).
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Configure OASSPI – Buttons

The following buttons are available in Configure OASSPI:

Configure OASSPI – Actions

Actions that you can perform depend upon the item that is selected in the tree and from where 
you access the action. The following actions can be accessed from the Actions menu, File 
menu, or by right-clicking on an item in the tree. 

Button Description

Cancel Exit Configure OASSPI.
If you set configuration properties without saving them, these changes 
are not saved.
If you added or removed an OC4J/OHS server, node, or group without 
saving the change or if you modified a configuration property, a Confirm 
Cancel window opens. Click Save and Exit to save the changes before 
exiting, Exit without Save to exit without saving the changes, or Return to 
Editing to continue editing the configuration (changes are not saved).

Finish Exit Configure OASSPI. Appears instead of Next if you launched 
Configure OASSPI without selecting any nodes.

Next Exit Configure OASSPI. Takes you to the “Confirm Operation” window 
that lists the nodes you selected before you started Configure OASSPI. 
The selected managed nodes’ configurations are updated with your 
changes. If you made changes to nodes that were not selected (are not 
displayed in the “Confirm Operation” window), the changes are saved to 
the HPOM management server’s configuration, but to make the 
changes to those managed node’s configuration, you must select those 
managed nodes from the node bank, restart Configure OASSPI, and 
then exit.

Save Save changes to the HPOM management server’s configuration and 
continue editing the configuration. You can also select File  Save to 
save your changes.

Action Description Selected Tree Item

Add OC4J/OHS Server Add an OC4J/OHS server. For more 
information, see Add OC4J/OHS 
Server on page 134.

OC4J/OHS Servers
Defaults
<Group_Name>
<Node_Name>

Add Group Create a group to which you can 
assign nodes that have common 
properties. For more information, 
see Add Group on page 135.

Any item in the tree
Any item in the tree

Add Node Add a managed node to the Nodes 
folder. For more information, see  
Add Node on page 135.

Any item in the tree
Any item in the tree
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Add OC4J/OHS Server

Add an Oracle OC4J/OHS Server instance at the global properties, GROUP, or NODE level in 
the Oracle AS SPI configuration.

To add an OC4J/OHS server, follow these steps:

1 Right-click one of the following items in the tree: Defaults (global properties level), OC4J/
OHS Servers (global properties level), <Group_Name> (GROUP level), or <Node_Name> 
(NODE level) and select Add OC4J/OHS Server.

The Configure OASSPI Application: Add OC4J/OHS Server window opens.

2 Enter the “OC4J/OHS Server Name.” This is the name of the OC4J/OHS server as defined 
in the Oracle Application Server and is case-sensitive. The Oracle Application Server 
Control Console displays the server names of all configured OC4J/OHS servers in a 
domain. Use these names for the OC4J/OHS Server Name.

3 Click OK.

Exit Exit the Configure OASSPI 
application. This action is available 
from the File menu. If any changes 
were made that have not been saved, 
the Confirm Cancel window opens.

Any item in the tree
Any item in the tree

Remove OC4J/OHS 
Server/Remove ALL 
OC4J/OHS Servers

Remove an OC4J/OHS server or all 
listed OC4J/OHS servers. For more 
information, see Remove OC4J/OHS 
Server/Remove ALL OC4J/OHS 
Servers on page 136.

OC4J/OHS Servers
<OC4J/

OHS_Server_Name>

Remove Group/Remove 
ALL Groups

Remove a Oracle AS SPI group or all 
listed Oracle AS SPI groups. For 
more information, see Remove 
Group/Remove ALL Groups on 
page 136.

Groups
<Group_Name>

Remove Node/Remove 
ALL Nodes

Remove a managed node or remove 
all managed nodes. For more 
information, see Remove Node/
Remove ALL Nodes on page 137.

Nodes
<Node_Name>

Save Save changes to the configuration. 
This action is available from the File 
menu only if changes were made to 
the configuration.

Any item in the tree
Any item in the tree

Set Configuration 
Properties tab

Set Oracle AS SPI configuration 
properties.  For more information, 
see Set Configuration Settings Tab 
on page 137.

<OC4J/
OHS_Server_Name>

Default Properties

View Configuration 
Settings tab

View Oracle AS SPI configuration 
properties. For more information, 
see View Configuration Settings Tab 
on page 138.

Any item in the tree
Any item in the tree

Action Description Selected Tree Item
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The NAME property is set.

The OC4J/OHS server is added and its properties are displayed. You can also set 
additional configuration properties for this server. For more information, see Set 
Configuration Settings Tab on page 137.

4 Click Save to save your changes.

If you do not want to add this OC4J/OHS server, right-click the OC4J/OHS server name, 
select Remove OC4J/OHS Server, and click Save.

Add Group

Assign nodes to a group that have common properties in the Oracle AS SPI configuration.

To add a group, follow these steps:

1 Right-click any item in the tree and select Add Group.

The Configure OASSPI Application: Add Group window opens.

2 Enter the Group Name. The group name identifies the group of nodes with common 
properties and is NOT case-sensitive.

3 Click OK.

The group is added and the Set Configuration Properties tab for the group is selected.

4 Select Add Node to Group, select one node from the list to add to the group, and click OK. 
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set pulldown 
list. For more information, see Set Configuration Settings Tab on page 137.

6 Click Save to save your changes.

If you do not want to add the group, right-click the group name, select Remove Group, and 
click Save.

Add Node

Add a managed node to the Oracle AS SPI configuration.

To add a node, follow these steps:

1 Right-click any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the following 
message appears:

All available managed nodes have been added to the configuration. 

Click OK to exit this action.

Otherwise, the Configure OASSPI Application: Add Node window opens.

2 From the pulldown menu, select a node to add.

3 Click OK.

The node is added and the Set Configuration Properties tab for the node displays.

4 Set the configuration properties for this node using the Select a Property to Set pulldown 
list. For more information, see Set Configuration Settings Tab on page 137.

5 Click Save to save your changes.
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If you do not want to add the node, right-click the node name, select Remove Node, and 
click Save.

Remove OC4J/OHS Server/Remove ALL OC4J/OHS Servers

Remove an OC4J/OHS Server or all listed OC4J/OHS Servers from the Oracle AS SPI 
configuration.

To remove an OC4J/OHS server, follow these steps:

1 Right-click the OC4J/OHS server name and select Remove OC4J/OHS Server.

The selected OC4J/OHS server name is removed from the list and its configuration 
properties are removed from the configuration.

2 Click Save to permanently remove the OC4J/OHS server.

Click Cancel to cancel the removal of the OC4J/OHS server (the OC4J/OHS server name 
appears the next time you run Configure OASSPI). In the Confirm Cancel window, click 
Exit without Save.

To remove ALL OC4J/OHS servers, follow these steps:

1 Right-click the OC4J/OHS Servers folder and select Remove ALL OC4J/OHS Servers.

The selected OC4J/OHS Servers folder and all OC4J/OHS servers listed in the selected 
folder are removed (all configuration properties for the listed OC4J/OHS servers are 
removed from the configuration).

2 Click Save to permanently remove the OC4J/OHS servers.

Click Cancel to cancel the removal of all OC4J/OHS servers (the OC4J/OHS Servers folder 
and all OC4J/OHS server names listed in the folder appear the next time you run 
Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

Remove Group/Remove ALL Groups

Remove a Oracle AS SPI group or all listed Oracle AS SPI groups from the Oracle AS SPI 
configuration.

To remove a group, follow these steps:

1 Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you 
run Configure OASSPI). In the Confirm Cancel window, click Exit without Save.
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Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the Oracle AS SPI configuration.

To remove a node, follow these steps:

1 Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the node.

Click Cancel to cancel the removal of the node (the node name appears the next time you 
run Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

To remove ALL nodes, follow these steps:

1 Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all 
configuration properties for the listed nodes are removed from the configuration).

2 Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed 
in the folder appear the next time you run Configure OASSPI). In the Confirm Cancel 
window, click Exit without Save.

Set Configuration Settings Tab

Set Oracle AS SPI configuration properties at the global properties level or for the selected 
OC4J/OHS server(s), group(s) (GROUP level), or node(s) (NODE level).

Items with the  icon are the only items for which you can set configuration properties 
(Default Properties and <OC4J/OHS_Server_Name>).

To set the configuration properties of an item, select the item and click the Set Configuration 
Properties tab in the right pane.

Setting a Property

To set a property in the configuration, follow these steps:

1 Select a property from the Select a Property to Set pulldown menu.

2 Select Set Property. The property and an empty value filed appear in the table.

3 Click the empty value field and enter a value.

4 Repeat steps 1 through 3 for each property to set.

5 Click Save.

Modifying a Property

To modify a property in the configuration, follow these steps:

1 Select the property from the table.

2 Double-click the value field.

3 Edit the value.

4 Repeat steps 1 through 3 for each property to modify.
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5 Click Save.

Removing a Property

To remove a property from the configuration, follow these steps:

1 Select the property from the table.

2 Click Remove Property.

3 Repeat steps 1 and 2 for each property to remove.

4 Click Save.

For more information about individual properties, see Configuration Properties on page 139.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the 
AUTO_DISCOVER property. You can only set this property by selecting or unselecting the 
check box.

Selecting the check box (default) causes the discovery templates (if distributed) to 
automatically update the Oracle AS SPI configuration information in the service map and 
configuration. If the discovery templates are not distributed, the service map is created but 
not updated.

View Configuration Settings Tab

View all Oracle AS SPI configuration properties set in the configuration on the HPOM 
management server or the Oracle AS SPI configuration properties for the selected OC4J/OHS 
server(s), group(s), or node(s).

To view the configuration properties of an item, select the item and click the View Configuration 
Settings tab in the right pane.

The following table describes the view when the specified item is selected.

Item Name Description of View

OC4J/OHS Servers View all configuration properties set for all the listed 
OC4J/OHS servers.

<OC4J/OHS_Server_Name> View all configuration properties set for the OC4J/OHS 
server (these properties can be modified by selecting the 
Set Configuration Properties tab).

Configurations View all configuration properties saved in the 
configuration on the HPOM management server.

Default Properties View all configuration properties that are set (these 
properties can be modified by selecting the Set 
Configuration Properties tab).

Defaults View all configuration properties set at the global 
properties level.

Groups View all configuration properties set for all the listed 
groups.
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View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting 
this check box, the view of the configuration properties changes to show all inherited 
properties (those properties defined at a global properties level or GROUP level) that affect 
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By unselecting this check box, the view shows only the configuration properties set at that 
level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after the 
property, the property cannot be modified at that level. For example, if the property HOME is 
set at the global properties level (under the Defaults folder), it can only be modified in the 
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after 
it) in a <Group_Name>’s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree. 
For example, if the property HOME is set at the global properties level (under the Defaults 
folder) and the property HOME is set at the GROUP level, the GROUP level property value 
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest:

1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level

Configuration Properties 

Table 5 on page 140 lists all properties by Oracle AS SPI requirements: 

<Group_Name> View all configuration properties set for the specific 
group.

Nodes View all configuration properties set for the listed 
nodes.

<Node_Name> View all configuration properties set for the specific 
node.

Item Name Description of View

Property Name of the property.

Requirements Lists the property requirements for specific components:

R - Required: The property must be set.

C - Conditional: The property might need to be set if certain 
conditions are met.

O - Optional: The property is not required for the 
component to work.
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blank - Not Applicable: The property does not affect this 
component.

Oracle AS SPI Configuration requirements for the Oracle AS SPI to work.

Discovery 
Process

Requirements for the discover process to work.

Auto-Discovered The property is automatically set by the discover process.

Level of 
Configuration

The level at which this property can be set within the configuration 
structure.

Default 
Properties

The global, group, or node level within the configuration structure.

Application 
Server

The server-specific level within the configuration structure.

Table 5 Properties Listed by Oracle AS SPI Requirements

Property

Requirements

Auto-
Discovered

Level of Configuration

Oracle 
AS SPI

Discovery 
Process

Default 
Properties

Application 
Server

HOME R C

JAVA_HOME R

LOGIN R

MAP_KEY_PREFIX R R

NAME R

PASSWORD R

URL_PATH        R          R

ALIAS C

AUTO_DISCOVER C C

GRAPH_URL C

RMID_PORT C

RMID_START_TIME C

START_CMD C

STOP_CMD C

TYPE C
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Property Definitions

USER C

VERSION C

MAX_ERROR_LOG_
SIZE

O

TIMEOUT O

Table 5 Properties Listed by Oracle AS SPI Requirements

Property

Requirements

Auto-
Discovered

Level of Configuration

Oracle 
AS SPI

Discovery 
Process

Default 
Properties

Application 
Server

Table 6 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description

ALIAS 9.04, 
10.1.2, 10.1.3

Conditional 
Required if more 
than one OC4J/
OHS server on a 
system share the 
same server 
name.

ALIAS is a unique name assigned to an OC4J/
OHS server on a managed node if more than 
one OC4J/OHS server on the managed node 
share the same server name. The alias, if set, is 
the name used in messages, reports, and 
graphs (otherwise, SERVER <n>NAME is 
used). 
If ALIAS is modified, the data for the old alias 
is saved but not mapped to the new alias.
Example: NODE petstore.hp.com 
{SERVER1_NAME=dog
SERVER1_ALIAS=beagle
SERVER2_NAME=dog
SERVER2_ALIAS=dachshund
}
NODE flying_ace.hp.com {
SERVER1_NAME=snoopy
SERVER1_ALIAS=beagle
SERVER2_NAME=snoopy
SERVER2_ALIAS=red_baron
}
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AUTO_DISCOVER 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
do not want the 
discovery policy 
to automatically 
overwrite the 
configuration 
information.

Select the AUTO_DISCOVER check box in the 
configuration editor to automatically update 
the Oracle Application Server configuration 
information in the service map and 
configuration. 
Unselect the AUTO_DISCOVER check box in 
the configuration editor if you are manually 
configuring the Oracle Application Server 
configuration and do not want the discovery 
template to automatically overwrite the 
configuration information. 

GRAPH_URL 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
want to use the 
View Graphs 
application (HP 
Performance 
Manager must be 
installed).

The fully-qualified URL used to launch HP 
Performance Manager. Set at the global level 
only.
Examples: GRAPH_URL = http://
<server_name>:<port_no>/OVPM (OVPM 8.10 
on Windows and Unix), the default port 
number is 8081

HOME 9.04, 
10.1.2, 10.1.3

Required The directory where the Oracle Application 
Server is installed. 
Example: 
HOME = /opt/oracle/infra

JAVA_HOME 9.04, 
10.1.2, 10.1.3

Required
Required by the 
discovery process 
if there is more 
than one 
directory where 
Java is installed.

The directory where Java is installed that is 
used by the collector. The java engine is 
expected to be $JAVA_HOME/bin/java.
Example: JAVA_HOME = /opt/oracle/jdk

LOGIN 10.1.3 Required An Oracle AS defined user (not a system user) 
that is used to monitor an Oracle AS server.
Example: SERVER1_LOGIN = janedoe

MAP_KEY_PREFIX 10.1.3 Required Any unique HTTP instance name.
Example: my_j2eeinstance1.system1.com

MAX_ERROR_LOG_SIZE 9.04, 
10.1.2, 10.1.3

Optional The maximum number of MB allowed for the 
error log file. When the error log file reaches 
the maximum limit, it is renamed as a backup 
file and logging resumes. When a new backup 
file replaces an old backup file, the old backup 
is deleted.
Default: 2MB
Example: 
MAX_ERROR_LOG_SIZE = 20

Table 6 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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NAME 9.04, 
10.1.2, 10.1.3

Required The OC4J instance name. Use the dcmctl 
listInstances command to display all Oracle 
Application Server instances.
This name is used in messages, reports, and 
graphs unless ALIAS is set. Set ALIAS to 
uniquely identify each server if more than one 
OC4J/OHS server on a system share the same 
name (NAME is the same within a NODE 
block).
Example: SERVER1_NAME = exampleServer

PASSWORD 10.1.3 Required The password for the LOGIN. If LOGIN is 
configured, a password must be defined. 
Example: 
SERVER1_PASSWORD = johndoe123

RMID_PORT 9.04, 
10.1.2, 10.1.3

Conditional
Required if the 
default port on 
which rmid 
listens is already 
in use.

Default: Oracle Application Server: 9240; JMX 
connector: 9241
The port on which rmid listens. By default, if 
an HPOM managed node is monitoring 
application server(s) and MBean server(s) 
using the JMX connector, the SPI uses two 
ports (one for the application server(s) and one 
for the MBean server(s)). For example, if you 
are monitoring an Oracle Application Server 
and an MBean server, the SPI uses ports 9240 
and 9241. If RMID_PORT is set, the SPI uses 
this one port for all servers (this property 
cannot be set at the application server level). 
For example, if you are monitoring a Oracle 
Application Server and an MBean server and 
set RMID_PORT to 9250, the SPI uses port 
9250 only.
Example: RMID_PORT = 9250 

RMID_START_TIME 9.04, 
10.1.2, 10.1.3

Conditional
Required if rmid 
takes longer than 
30 seconds to 
start.

Default: 30 (seconds)
The amount of time, in seconds, to wait for 
rmid to start before timing out.
Example: RMID_START_TIME = 60

Table 6 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
The Configuration 143



START_CMD 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
want to start the 
Oracle 
Application 
Server from the 
HPOM console

A fully qualified system command that is run 
when the HPOM Application Bank “Start 
Oracle AS” application is used. This command 
is run by USER which must be set in order for 
the “Start Oracle AS” application to work. 
NOTE: This command must exit. That is, the 
Oracle Application Server process must run in 
the background or as a service and it must be 
protected from its parent process dying. 
Example: SERVER1_START_CMD = 
/sbin/init.d/oracle start

STOP_CMD 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
want to stop the 
Oracle 
Application 
Server from the 
HPOM console

A fully qualified system command that is run 
when the HPOM Application Bank “Stop 
Oracle AS” application is used. This command 
is run by USER which must be configured in 
order for the “Stop Oracle AS” application to 
work. 
Example: SERVER1_STOP_CMD = 
/sbin/init.d/oracle stop

TIMEOUT 9.04, 
10.1.2, 10.1.3

Optional Default: 120 (seconds). The maximum amount 
of time, in seconds, Oracle AS SPI tries to 
connect to the Oracle Application Server. When 
the specified time is exceeded, Oracle AS SPI 
sends an alarm to the message browser 
indicating that the Oracle Application Server is 
unavailable. If metric C002_ServerStatusRep 
is being collected, the unavailability of the 
server is logged. 
If no time limit is desired, set this property to 
-1. 

TYPE 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
are configuring a 
JMX connector

Default: ajp13. The type of JMX connector. Set 
to ajp13 if this is an OC4J server. Set to ohs if 
this is an OHS (HTTP_Server) server. Set to 
ovrmi if you are configuring a JMX connector.
Example: SERVER1_TYPE=ajp13

URL_PATH 10.1.3 Required Required for discovery and collection of 
metrics. It is a mandatory property that every 
server in the SiteConfig must have.
Example: SERVER2_URL_PATH=/opmn://
samplesystem:6005/my2_home

Table 6 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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USER 9.04, 
10.1.2, 10.1.3

Conditional
Required if you 
want to start and/
or stop the Oracle 
Application 
Server from the 
HPOM console

The system username for starting and stopping 
the Oracle Application Server from the HPOM 
Application Bank. 
The default is the username under which the 
HP Operations agent runs.
Example: USER = ias_admin

VERSION 9.04, 
10.1.2, 10.1.3

Conditional
Required for 
Oracle 
Application 
Server version 
10.1.2, 10.1.3

The version number of the Oracle Application 
Server in the format Major# [Minor#] where:
Major# - The primary version number (for 
example, 10.1) 
Minor# - The service pack installed (for 
example, 1 for SP1). If Minor# is not specified, 
it defaults to 0 (no service pack installed).
Example: SERVER1_VERSION = 10.1 2

Table 6 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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Sample Configurations for the Oracle AS SPI

Example 1: Single Node/Two Servers

This example is for a single node running two servers: an OC4J and HTTP servers. The 
properties HOME, JAVA_HOME, MAP_KEY_PREFIX, and VERSION are global defaults 
that apply to all servers and nodes. 

HOME=C:/OraHome_1
JAVA_HOME=C:/OraHome/jdk
MAP_KEY_PREFIX=
VERSION=10.1 2
NUM_SERVERS=2
NODE some_node.hp.com
{
SERVER1_NAME=HTTP_Server
SERVER1_TYPE=ohs
SERVER2_NAME=home
SERVER2_TYPE=ajp13

}

Example 2: Multiple Nodes/Repeated Properties

This example shows how you can configure a group of related systems that have numerous 
properties in common. Some nodes, however, might have one or two properties that you need 
to set differently. You can address these kinds of situations in three steps: 

1 Use the Add Group action in the configuration editor to name the group, specify the nodes 
in it, and set the configuration properties. For more information, see Add Group on 
page 135.

2 Use the Add Node action in the configuration editor to define individual node properties 
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). For more information, see Add Node on page 135.

In the example, the global default properties HOME, JAVA_HOME, and MAP_KEY_PREFIX are 
overridden for SERVER4 and SERVER5 of the node group “production” and for node 
europa.hp.com. 

HOME = /opt/oracle/appsrv
JAVA_HOME = /opt/oracle/appsrv/jdk
MAP_KEY_PREFIX = /appsrv.hp.com
VERSION = 10.1 2
GROUP production
{
mercury.hp.com
venus.hp.com
mars.hp.com
jupiter.hp.com

}

Properties set for a node take precedence over the same properties set for a group. See 
Property Precedence on page 130 for the complete order of property precedence.
146 Appendix B



NODE production
{
SERVER1_NAME = HTTP_Server
SERVER1_TYPE = ohs

     SERVER1_ALIAS = HTTP_Server+appsrv.hp.com
SERVER2_NAME = OC4J_Portal
SERVER2_TYPE = ajp13
SERVER3_NAME = home
SERVER3_TYPE = ajp13
SERVER4_NAME = HTTP_Server
SERVER4_TYPE = ohs

     SERVER4_ALIAS = HTTP_Server+infra.hp.com
SERVER4_HOME = /opt/oracle/infra
SERVER4_JAVA_HOME = /opt/oracle/infra/jdk
SERVER4_MAP_KEY_PREFIX = /oasspi/infra.hp.com
SERVER5_NAME = OC4J_SECURITY
SERVER5_TYPE = ajp13
SERVER5_HOME = /opt/oracle/infra
SERVER5_JAVA_HOME = /opt/oracle/infra/jdk
SERVER5_MAP_KEY_PREFIX = /oasspi/infra.hp.com

}
NODE europa.hp.com
{
SERVER1_NAME = OC4J_SECURITY
SERVER1_TYPE = ajp13
SERVER1_HOME = /opt/oracle/infra
SERVER1_JAVA_HOME = /opt/oracle/infra/jdk
SERVER1_MAP_KEY_PREFIX = /oasspi/infra.hp.com

}
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C Applications
The Oracle AS SPI applications include configuration and troubleshooting utilities.

OASSPI Admin applications include:

• Configure OASSPI

• Discover Oracle AS

• Init Non-Root

• Self-Healing Info

• Start/Stop Monitoring

• Start/Stop Tracing

• Verify

• View Error Log

• View Graphs

Oracle AS SPI applications include:

• Launch Oracle AS Console

• Start/Stop Oracle AS

• View OAS Logs

• View Status
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OASSPI Admin Applications Group

OASSPI Admin applications enable you to configure, control, and troubleshoot the Oracle AS 
SPI. The OASSPI Admin applications group includes the following applications: 

Configure OASSPI

Configure OASSPI application launches the configuration editor and enables you to manage 
the Oracle AS SPI configuration by viewing, editing, or setting configuration properties

If you are configuring the Oracle AS SPI for the first time, you must use the Discover Oracle 
AS application to automatically set basic configuration properties. For complete instructions 
on how to configure Oracle AS SPI, see Chapter 3, Configuring the Oracle AS SPI.

Function

Configure OASSPI performs the following functions:

• Updates the configuration on the HPOM management server and managed nodes.

• Creates the directories and files required by Oracle AS SPI on the selected managed 
nodes.

• Sets up data sources for reporting and graphing

• Sets up the Oracle Application Server log files and Oracle AS SPI error log file for 
monitoring

The HPOM management server maintains the configuration information for all Oracle 
Application servers on HP Operations Manager managed nodes. Each managed node 
maintains a subset of the configuration information maintained on the management server. 
The configuration information of Oracle Application servers on a node is maintained on that 
managed node. 

When you make changes to the configuration using the configuration editor, the changes are 
always saved on the HPOM management server. 

If you select a specific HPOM managed node when you launch Configure OASSPI, 
configuration changes affecting Oracle Application Servers running on that node are 
automatically saved on the node. If you do not select a managed node, the configuration 
changes are not saved on the managed node. 

Configuration changes affecting non-selected managed nodes are saved to the configuration 
on the HPOM management server and not on the non-selected managed node. To save the 
changes on the node, you must select the managed node and re-run the Configure OASSPI 
application. 

To Launch the Configure OASSPI Application

1 From the HPOM console, select the nodes in the Node Bank window. 

2 Select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Configure OASSPI. (If 
the items do not appear, select Map  Reload.) The Introduction window opens. 

4 Click Next. The configuration editor opens. For more information about using the 
configuration editor, see Using the Configuration Editor on page 131.
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5 Optionally, click Save to save any changes made to the configuration. Once you save your 
changes, you cannot automatically undo them.

6 Click Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Click OK.

7 If you added an application server or added/edited the HOME and/or JAVA_HOME properties, 
run the Discover Oracle AS application on the managed nodes on which the application 
server/properties were added or edited. Running the Discover Oracle AS application 
updates the service map.

Discover Oracle AS

Discover Oracle AS launches the configuration editor that you can use to configure Oracle AS 
SPI by setting basic configuration properties needed for discovery. 

The Discover Oracle AS application deploys the discovery templates on the managed nodes. 
These polices automatically discover instances of Oracle Application servers on the managed 
nodes and update the configuration.

Function

Discover Oracle AS updates the configuration on the HP Operations Manager (HPOM) 
management server and selected managed nodes.

Configuration information for all Oracle OC4J/OHS servers on all HPOM managed nodes is 
maintained on the HPOM management server.
Each managed node maintains a subset of the information maintained on the management 
server. The managed node maintains configuration information about the OC4J/OHS servers 
running on that node. 

You must select an HPOM managed node before you launch this application. All configuration 
changes made to the Oracle OC4J/OHS server on the selected node is automatically saved on 
that node.

If the changes affect a server on a non-selected node, then the changes are saved to the 
configuration on the management server and not on the non-selected node. To save the 
changes on the managed node, select that managed node and re-run the Discover Oracle AS 
application.

To Launch the Discover Oracle AS Application

Launch the Discovery application on one managed node at a time.You must run the Discover 
Oracle AS application to set the basic configuration properties required for the Oracle AS SPI 
to discover instances of the Oracle Application Server, deploy the Oracle AS SPI discovery 
templates, and update the service map. 

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Configure OASSPI application, click Next from the 
configuration editor, and then click OK.

If an instance of Oracle AS Server has a server login name and password different from the 
default login and password, before launching the discovery tool you must explicitly configure 
the login details for that server using the configuration editor.
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Follow these steps: 

1 At the HPOM console, double-click OVO Node Bank. The OVO Node Bank window opens. 

2 From the Window menu, select Application Bank. The OVO Application Bank opens in a 
new window.

3 Double-click OASSPI. The Application Group: OASSPI window opens.

4 Double-click OASSPI Admin. The Application Group: OASSPI Admin window opens. All the 
OASSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Discover Oracle AS (If the 
above does not appear as described, select Map  Reload.) The Introduction window opens. 
This window contains brief information about the Discovery application.

6 Click Next. A second Introduction window opens. This window displays information about 
the properties that might be required for the discovery process to work.

7 Click Next. If you already set the LOGIN and PASSWORD properties, the configuration 
editor opens.

If you did not set the LOGIN and PASSWORD properties, the Set Access Info for Default 
Properties window opens.

8 Set the same LOGIN and PASSWORD properties as configured in the Oracle AS login and 
password in Task2: Configure a Oracle AS Server User on page 40. 

9 Click Next. The configuration editor opens.

10 From the configuration editor, set the configuration properties. For more information 
about using the configuration editor, see Appendix B, The Configuration.

11 Click Next to save any changes and exit the editor.

12 The Confirm Operation window opens. Verify the nodes on which the operation is to be 
performed. Click OK.

Init Non-Root

Updates the /var/opt/OV/bin/instrumentation/wasspi_oas_platdef.pm file and 
generates the wasspi_oas_sudoers configuration file on the selected managed nodes.

This application simplifies the configuration of a non-root HTTPS agent on a UNIX managed 
node (HPOM for UNIX 8.x only). For all the steps necessary to configure a non-root HTTPS 
agent on a UNIX managed node, see Configuring a Non-Root HTTPS Agent on a UNIX 
Managed Node (OVO 8.x Only) on page 50.

The LOGIN and PASSWORD properties set in this window are used as the default 
Oracle AS login and password (they are set at the global properties level). That is, 
if no NODE level or server-specific LOGIN and PASSWORD properties are set, 
this Oracle AS login and password are used by the Oracle AS SPI to access all 
Oracle AS servers. For more information about the configuration structure, see 
Structure on page 129.

If you click Cancel and made changes to the configuration, those changes remain in 
the configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, start the Discover Oracle AS application, click Next from the configuration 
editor, and then click OK.
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Function

The Init Non-Root application performs the following functions on the selected managed 
nodes:

1 Runs the wasspi_oas_perl -S wasspi_oas_makePlatdef -force command to set the 
proper SPI path configuration and updates the 
/var/opt/OV/bin/instrumentation/wasspi_oas_platdef.pm and 
wasspi_oas_platdef.prop files.

2 Generates the wasspi_oas_sudoers configuration file.
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To Launch the Init Non-Root Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Init Non-Root. 

Self-Healing Info 

The Self-Healing Info Application collects data that you can send to your HP support 
representative.

Required Setup

If you are collecting data for a reproducible problem, follow these steps before running the 
Self-Healing Info application:

1 Run the Start Tracing application. For more information, see Start/Stop Tracing on 
page 155.

2 Reproduce the problem.

Function

Self-Healing Info application performs the following functions:

• Saves data in in the following file:

— on a UNIX managed node: /tmp/wasspi_oas_support.tar

— on a Windows managed node: wasspi_oas_support.zip in %TEMP% directory.

• Launches and saves data using the Verify application (for more information, see Verify on 
page 156).

To Launch the Self-Healing Info Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Self-Healing Info. 

This file might be hidden on some Windows managed nodes. If you do not see the 
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click 
the View tab. Under Hidden files and folders, select Show hidden files and folders.
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Start/Stop Monitoring

When you launch the Start/ Stop Monitoring application, the Oracle AS SPI starts/stops 
collecting metrics for OC4J/OHS server instances on a managed node.

Function

• Start Monitoring starts the collection of metrics for one or all OC4J/OHS servers on a 
managed node.

These metrics generate alarms when thresholds are exceeded. You can also use the 
metrics to create reports (automatically or manually generated) and graphs. These 
reports and graphs are used to analyze trends in server usage, availability and 
performance. 

• Stop Monitoring stops the collection of metrics for one or all OC4J/OHS servers on a 
managed node.

You  can stop monitoring on a managed node if the node is not running for a known reason 
(for example, the node is down for maintenance). Stopping the monitoring prevents 
unnecessary alarms from being generated.

You can launch the Verify application to check whether the monitoring has started or stopped. 
By default, monitoring is on. 

To Launch the Start/Stop Monitoring Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Start Monitoring or Stop 
Monitoring. 

Start/Stop Tracing

Starts/stops the tracing of the collection of metrics.

Purpose 

Starts/stops the tracing of the collection of metrics into a file. Run this application only when 
instructed by your HP support representative.

Run the Self-Healing Info application to collect the file(s) created by this application as part of 
the data to be used by your HP support representative.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.

To Launch the Start/Stop Tracing Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.
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3 In the Application Bank window select OASSPI  OASSPI Admin and double-click Start 
Tracing or Stop Tracing. 

Verify

You can run the Verify application to check whether the Oracle AS SPI is installed properly on 
the server and managed nodes.

Function

The Verify application performs the following actions on all managed nodes:

• Checks that the following directories exist:

— <OV_AGT_DIR>/wasspi/oas/conf/

— <OV_AGT_DIR>/wasspi/oas/datalog/

— <OV_AGT_DIR>/wasspi/oas/history/

— <OV_AGT_DIR>/wasspi/oas/lib/

— <OV_AGT_DIR>/wasspi/oas/log/

— <OV_AGT_DIR>/wasspi/oas/tmp/

• Checks that the following files exist:

— <OV_AGT_DIR>/wasspi/oas/conf/logSetup

— <OV_AGT_DIR>/wasspi/oas/conf/MetricMap

— <OV_AGT_DIR>/wasspi/oas/conf/OVTrace.tcf.on

— <OV_AGT_DIR>/wasspi/oas/conf/SiteConfig

— <OV_AGT_DIR>/wasspi/oas/conf/SPIConfigLogFiles

— <OV_AGT_DIR>/wasspi/oas/conf/version

— <OV_AGT_DIR>/wasspi/oas/lib/castor.jar

— <OV_AGT_DIR>/wasspi/oas/lib/GraphSP.xsl

— <OV_AGT_DIR>/wasspi/oas/lib/JspiCola.jar

— <OV_AGT_DIR>/wasspi/oas/lib/MetricMap.xsl

— <OV_AGT_DIR>/wasspi/oas/lib/SiteConfig

— <OV_AGT_DIR>/wasspi/oas/lib/xalan.jar

— <OV_AGT_DIR>/wasspi/oas/lib/xerces.jar

— <OVOAGT_CMDDIR>/ovtrc3.jar

— <OVOAGT_CMDDIR>/SPI_DiscClient.ps

— <OVOAGT_CMDDIR>/spi_oas.xml

— <OVOAGT_CMDDIR>/wasspi_oas_DiscReg.txt

Before you launch the Verify application ensure that you installed the latest version of 
Self-Healing Service (SHS) component from the SPI DVD.
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— <OVOAGT_CMDDIR>/wasspi_oas_platdef.pm

— <OVOAGT_CMDDIR>/wasspi_oas_platdef.prop

— <OVOAGT_CMDDIR>/wasspi_oas_shs_agent_install.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_input.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_server_install.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_task.xml

— <OVOAGT_CMDDIR>/wasspi_oas_traceConfig.xml

— <OVOAGT_CMDDIR>/wasspi_oas_util.vbs

— <OVOAGT_CMDDIR>/wasspi_oas_xalan.jar

— <OVOAGT_CMDDIR>/wasspi_oas_xerces.jar

— <OVOAGT_CMDDIR>/xerces.jar

— <OVOAGT_MONDIR>/wasspi_oas_cat

— <OVOAGT_MONDIR>/wasspi_oas_makePlatdef

• Checks that the following files exist and the version is A.04 or higher:

— <OV_AGT_DIR>/wasspi/oas/conf/MBeanReports.dtd

— <OV_AGT_DIR>/wasspi/oas/conf/MBeanReports.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/MetricDefinitions.dtd

— <OV_AGT_DIR>/wasspi/oas/conf/ReportsHeader.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/ReportsUtil.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/SPIConfig

— <OV_AGT_DIR>/wasspi/oas/lib/JSpiCola.jar

— <OVOAGT_CMDDIR>/wasspi_oas_admin

— <OVOAGT_CMDDIR>/wasspi_oas_discovery.pl

— <OVOAGT_CMDDIR>/wasspi_oas_spiapps

— <OVOAGT_MONDIR>/wasspi_oas_ca

— <OVOAGT_MONDIR>/wasspi_oas_configBasic

— <OVOAGT_MONDIR>/wasspi_oas_configCheck

— <OVOAGT_MONDIR>/wasspi_oas_configLogs

— <OVOAGT_MONDIR>/wasspi_oas_configPerf

— <OVOAGT_MONDIR>/wasspi_oas_files

— <OVOAGT_MONDIR>/wasspi_oas_le

— <OVOAGT_MONDIR>/wasspi_oas_lib.pl

— <OVOAGT_MONDIR>/wasspi_oas_logdata

— <OVOAGT_MONDIR>/wasspi_oas_trace.pm

— <OVOAGT_MONDIR>/wasspi_oas_udmgraphs

Verify application performs the following actions on the management server:

• Checks that the following directories exist:
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— /opt/OV/wasspi/oas/conf/

— /opt/OV/wasspi/oas/bin/

— /opt/OV/wasspi/oas/lib/

• Checks that the following files exist:

— /opt/OV/wasspi/oas/conf/SiteConfig

— /opt/OV/wasspi/oas/conf/SPIConfig

— /opt/OV/wasspi/oas/lib/JSpiCola.jar

— /opt/OV/wasspi/oas/lib/wasspi_config_gui.jar

— /opt/OV/wasspi/oas/lib/xalan.jar

— /opt/OV/wasspi/oas/lib/xerces.jar

— /opt/OV/wasspi/oas/lib/MetricDefinitions.dtd

— /opt/OV/wasspi/oas/lib/images/details.gif

— /opt/OV/wasspi/oas/lib/images/properties.gif

— /opt/OV/wasspi/oas/lib/images/OpenView.gif

— /opt/OV/wasspi/oas/lib/help/intro_configure.html

— /opt/OV/wasspi/oas/lib/help/intro_discover.html

— /opt/OV/wasspi/oas/lib/help/instruct_discover.html

— /opt/OV/newconfig/OVPM/VPI_GraphsOASSPI.txt

— /opt/OV/newconfig/OVPM/OASSPI_FormTemplate.txt

— /opt/OV/newconfig/OVPM/OASSPI_FrameTemplate.txt

— /opt/OV/OVPM/webapps/OVPM/OASSPI_Empty.htm

• Checks that the following files exist and the version is A.04 or higher:

— /opt/OV/wasspi/oas/bin/parseDefs.pl

— /opt/OV/wasspi/oas/bin/processWASSPIDiscovMsg.pl

— /opt/OV/wasspi/oas/bin/startOASConsole.pl

— /opt/OV/wasspi/oas/bin/updateMasterConfig.pl

— /opt/OV/wasspi/oas/bin/wasspi_getOpcNodes

— /opt/OV/wasspi/oas/bin/wasspi_oas_app_graphs

— /opt/OV/wasspi/oas/bin/wasspi_oas_editConfig

— /opt/OV/wasspi/oas/bin/wasspi_oas_makePlatdef

— /opt/OV/wasspi/oas/bin/wasspi_oas_optaction_graphs

— /opt/OV/wasspi/oas/bin/wasspi_oas_xterm

— /opt/OV/wasspi/oas/lib/wasspi_oas_serverLib.pm

Verify application performs the following actions on Windows managed nodes:

• Checks that the following files exist:

— <OVOAGT_CMDDIR>\spi_oas.cmd

— <OVOAGT_CMDDIR>\spi_oas_runSHSCollector.cmd
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— <OVOAGT_MONDIR>\wasspi_oas_opcagt.cmd

— <OVOAGT_MONDIR>\wasspi_oas_perl.cmd

• Checks that the following files exist and the version is A.04 or higher:

— <OVOAGT_CMDDIR>\wasspi_oas_util.vbs

— <OVOAGT_MONDIR>\wasspi_oas_config.cmd

— <OVOAGT_MONDIR>\wasspi_oas_readRegistryKeys.vbs

Verify application performs the following actions on UNIX managed nodes:

• Checks that the following files exist:

— <OVOAGT_CMDDIR>/spi_oas.sh

— <OVOAGT_CMDDIR>/spi_oas_runSHSCollector.sh

— <OVOAGT_MONDIR>/wasspi_oas_opcagt

— <OVOAGT_MONDIR>/wasspi_oas_setpath

• Checks that the following files exist and the version is A.04 or higher:

— <OVOAGT_CMDDIR>/wasspi_oas_installFile

— <OVOAGT_CMDDIR>/wasspi_oas_osinfo

— <OVOAGT_CMDDIR>/wasspi_oas_processLib.pl

— <OVOAGT_MONDIR>/wasspi_oas_config

— <OVOAGT_MONDIR>/wasspi_oas_perl

— <OVOAGT_MONDIR>/wasspi_oas_xterm

• Checks that the following files exist and the version is A.01.30.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp.exe

— <OVOAGT_MONDIR>/ddfcomp_coda.exe

— <OVOAGT_MONDIR>/ddflog.exe.pl

— <OVOAGT_MONDIR>/ddflog_code.exe

— <OVOAGT_MONDIR>/ddfutil.exe

Verify application performs the following actions on Linux managed nodes:

• Checks that the following files exist and the version is A.01.30.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda

— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

Verify application performs the following actions on OSF managed nodes:

• Checks that the following files exist and the version is A.01.23.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda
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— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

Verify application performs the following actions on HP-UX, Solaris, AIX,and other UNIX 
managed nodes:

• Checks that the following files exist and the version is A.01.20.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda

— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

In this instance, <OV_AGT_DIR> is:

• on a UNIX managed node: /var/opt/OV 

• on a Windows managed node: depends on the installation of the product 

and <OVO_CMDDIR>:

• on an HTTPS managed node is: <OV_AGT_DIR>\bin\instrumentation

and <OVO_MONDIR> :

• on an HTTPS managed node is: <OV_AGT_DIR>\bin\instrumentation

To Launch the Verify Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  Verify.

If the Verify application is successful, the following message appears:

Installation is clean
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View Error Log

You can use the View Error Log application to view the contents of the Oracle AS SPI error log 
file.

Function

View Error Log displays the contents of the Oracle AS SPI error log file <OV_AGT_DIR>/log/
oasspsi/errorlog.

In this instance, <OV_AGT_DIR> typically is:

• /var/opt/OV on UNIX managed nodes

• /Program Files/HP OpenView/Installed Packages/
{790 ...} on Windows managed nodes

To View the Oracle AS SPI Error Log

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  View Error Log. 

View Graphs

You can use the View Graphs application to view HP Performance Manager graphs in a web 
browser. 

Required Setup

HP Performance Manager must be installed and you must edit the ovweb.conf file before 
this application can run successfully. For more information, see Task 1: Configure the 
Management Server to Launch Your Web Browser on page 35. 

If you are using Netscape Navigator, use version 6.0 or higher. Do not use Netscape Navigator 
4.79 with this application.

Function

The View Graphs application launches a web browser to display, as graphs, the Oracle AS SPI 
metric data. These graphs are generated using HP Performance Manager. 

To Launch the View Graphs Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  OASSPI Admin  View Graphs. 
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Oracle AS SPI Applications Group

The applications in the Oracle AS SPI group provide you access to the functions of Oracle 
Application Server from the HPOM console. The Oracle AS SPI applications group includes 
the following applications:

Launch Oracle AS Console

By running the Launch Oracle AS Console application you can bring up the Oracle 
Application Server Control Console.

Required Setup

• Edit the ovweb.conf file before launching this application. For more information, see 
Task 1: Configure the Management Server to Launch Your Web Browser on page 35.

• Install Oracle AS Enterprise Manager on the managed node to launch the Oracle 
Enterprise Manager Database Control. 

Function

Launch Oracle AS Console brings up the Oracle Application Server Admin Console in a web 
browser for a single application server or all application servers on the selected node. 

To Launch the Launch Oracle AS Console Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  Oracle AS  
Launch Oracle AS Console.

4 Select an option:

— 1 - Launch the Oracle Application Server Control Console

— 2 - Launch AggreSPY

— 3 - Launch the Oracle Enterprise Manager Database Control (Oracle AS Enterprise 
Manager must be installed on the managed node for this option to be available)

— q - Quit the application

Start/Stop Oracle AS

You can start or stop one or more instances of Oracle Application Servers from the HP 
Operations Manager (HPOM) console by running the Start Oracle AS application, without 
logging in to each individual Oracle Application Server Control Consoles.

Required Setup

The START_CMD, STOP_CMD, and USER configuration properties must be set before this 
application can run successfully.
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Function

Start or Stop Oracle AS application starts or stops one or all application servers on the 
selected managed nodes.

To Launch the Start/Stop Oracle AS Application

1 At the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  Oracle AS  
Start Oracle AS or Stop Oracle AS. 

View OAS Logs

You can use View OAS Logs application enables you to view Oracle Application Server log 
files without logging in to the system on which the Oracle Application Server is running.

Function

View OAS Logs application performs the following functions:

• If you launch View OAS Logs without a parameter, the application displays a numbered 
list of available log files for the selected managed node. 

• If you launch View OAS Logs with an invalid parameter (a non numeric value or a 
number that does not correspond to the list of available log files), the application displays 
a numbered list of available log files for the selected managed node. 

• If you launch View OAS Logs with an valid parameter, the application displays the 
contents of the corresponding log file for the selected managed node. 

You can enter only one numeric value in the parameter field and view the log file 
corresponding to that number. Select one log file to view per managed node every time you 
launch the View OAS Logs application.

If you keep the Application Status window open and relaunch the application, the output in 
the Application Status window accumulates.

To Launch the View OAS Logs Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  Oracle AS  
View OAS Logs.

4 Select the managed nodes on which you want to view the Oracle Application Server log 
file.

5 Click Launch. The Edit Parameters window appears. If you know the number of the log file 
you want to view, enter it into the Parameters field. Otherwise, leave this field blank to 
list available log files to view.

6 Click Launch. The Application Status window opens.

7 In the Launched Applications field, check the Status of the application for each node:
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• Started/Starting - The application is running.

• Succeeded - A list of available log files to view opens. Select the node in the Launched 
Applications field and scroll through the Application Output field to view the list of 
available log files.

• Failed - The application did not succeed. For more information about the problem, 
select the node in the Launched Applications field and scroll through the Application 
Output field.

8 Double-click View OAS Logs.

9 Select the managed nodes on which you want to view the Oracle Application Server log 
file.

10 Click Launch. The Edit Parameters window appears.

11 In the Parameters text box, enter the number of the log file you want to view. Only one log 
file can be selected.

If you do not remember the number of the log file, go to the Application Status window, 
select the node in the Launched Applications field, scroll through the Application Output 
filed to view the list of available log files, and enter the number of the log file you want to 
view in the Edit Parameters window.

12 Click Launch.

13 In the Application Status window, select the node on which to view the selected log file 
and scroll through the Application Output filed to view the log file.

14 Repeat steps 8-13 for each log file you want to view.

15 Click Close to close the Application Status window.

View Status

The View Status application displays a status report of the Oracle Application Servers 
running on a selected managed node. You can use this application to check the status of each 
application server running on the node. 

Function

View Status displays the Oracle Application Server instance name, hostname, Oracle home, 
and processes (component, type, process ID, and status) for each application server instance.

To Launch the View Status Application

1 At the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI  Oracle AS  View Status. 
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Glossary
agent

A program or process running on a remote device or computer system that responds to 
management requests, performs management operations, or sends performance and event 
notification. An agent can provide access to managed objects and MIB variables, interpret 
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related 
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but 
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is run in response to an event, message, or a change 
in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service 
from another computer (server). When the context is software, a program or executable 
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs 
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out. 
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that 
make up the network. For example the components of a network can include computer 
systems, routers, switches, hubs, operating systems and network software. The configuration 
of the network determines the way that it works and the way that it is used. In a software 
context, the combination of settings of software parameters and attributes that determine the 
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a 
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified 
environment, application or usage. 

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of 
applications.

customization

The process of designing, constructing or modifying software to meet the needs and 
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular 
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically 
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the 
business environment.

Deployed application

An application and its components that are installed and started to work in the business 
environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that 
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.
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event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated 
by an agent or process in a managed object or by a user action. Events usually indicate a 
change in the state of a managed object or cause an action to occur. 

HP Operations Manager

A family of network and system management products, and an architecture for those 
products. HP Operations Manager includes development environments and a wide variety of 
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure. 

icon

An on-screen image that represents objects that can be monitored or manipulated by the user 
or actions that can be started by the user.

managed object

A network, system, software or service object that is both monitored for performance, status 
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application 
or set of management applications. The console might be on the system that contains the 
management software or it might be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to 
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of 
one or more events relative to specified conditions, or a change in application, system, 
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an 
event, the evaluation of one or more events relative to specified conditions or a change in 
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from 
particular events.The string summarizes the important characteristics of the event. Message 
keys can be used to allow messages to acknowledge other messages, and allows for the 
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that 
initiated the message. See also severity level.

metadata

Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT 
environments. Management products are added or "snapped into" the management console 
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the 
presentation of a specific type of data. Modules can interact with one another and with other 
software.

node

When the context is network, a computer system or device (for example, printer, router, 
bridge) in a network. When the context is a graphical point to point layout, a graphical 
element in a drawing that acts as a junction or connection point for other graphical elements.

parameter

A variable or attribute that might be given an arbitrary value for use during an execution of 
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data 
that is valid for the parameter. For example a parameter type could be IP Address which 
indicates that parameter values must have 4 numbers separated by decimals with the value 
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

templates

A set of one or more specifications rules and other information that help automate network, 
system, service, and process management. Templates can be deployed to various targets (for 
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example, managed systems, devices, network interfaces) providing consistent, automated 
administration across the network.

Policy management

The process of controlling templates (for example, creating, editing, tracking, deploying, 
deleting) for the purposes of network, system or service management.

policy type

An abstraction or categorization of templates based on the function of the policy or the 
services that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device. 
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for 
example, management capabilities, file storage capabilities) to other computer systems 
(clients) on the network. If the context is a software component, a program or executable 
process that responds to and services requests issued by clients.

severity level

A property of an object indicating the status of the object. Severity level is based on the impact 
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management 
capabilities specific to a given type of business application, database, operating system, or 
service.

trace log

An output file containing records of the execution of application software
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HP Performance Manager
integrating with OAS SPI, 72

I
Init Non-Root application, 19, 152

how to run, 154
what it does, 153

installing, 25
OAS SPI report package, 70
swinstall, 25

instruction text
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J
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OASSPI-Monitors, 23

JMX Metric Builder application, 22
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L
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M
managed nodes

adding to OAS SPI node group, 44
configuring, 40
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N
NAME property, 143

Next button, 133

NODE block, 130
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O
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overview, 14
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OASSPI-Discovery template, 23
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OAS SPI node group
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OAS SPI Reports application group, 21

OASSPI-Schedule template group, 23

OASSPI Service Discovery, 23

OASSPI Template Group, 22

operator
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Oracle AS application group, 20
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